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Welcome and Participant Information 
As a CONNECTIONS user, you are contributing to New York State’s child welfare data 
management system. Timely record keeping and documentation is an essential part of 
maintaining an accurate and reliable database. This guide is meant to provide detailed 
instructions for updating or correcting CPS stage information in CONNECTIONS. 

The Content of this Guide 
This guide contains step-by-step instructions for accomplishing necessary updates or changes 
in CONNECTIONS, introductory remarks that provide a work context for these tasks, and hints 
on how to carry out these tasks efficiently and effectively.  

  

Note: 
Any visible identifying data 
in this guide is simulated. 

 

 

Features of this Guide 
The features of this guide help you quickly identify the information you need: 

• Tips, set apart in margin boxes, provide information to help you carry out 
CONNECTIONS tasks efficiently and effectively. Icons in the boxes help focus your 
attention on three kinds of tips: 

Bright ideas 

Helpful hints 

Things to watch out for 
 

• 

 

CPS Case Recording Guidelines contain step-by-step instructions for meeting 
qualitative standards. These are based on OCFS policy and are presented to assist 
caseworkers in documenting casework. 

• Subdivided Instructions: The step-by-step instructions for each procedure are 
subdivided into major sub-steps to make it easier to jump ahead to the correct step if 
you’re already on the window you need to access. After the initial instructions on how to 
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sign on to the system and access CONNECTIONS, step-by-step instructions assume 
you have accessed the CONNECTIONS Toolbar.  

We hope you find this to be a useful aid in your CPS work! 
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Logging On to Your PC 

Only designated individuals on computers that are set up to run the application can access the 
CONNECTIONS application. This section addresses the procedures for logging on to the 
Windows 2000 operating system.  

Once you have completed logging on to Windows, the step-by-step instructions in the next 
section will show you how to access CONNECTIONS. 

 

Step-by-Step: 
Logging On to Your Computer 

1 Press the Ctrl + Alt + Delete keys on your keyboard at the same time. 
A Confidentiality warning displays. 

2 Click on the OK button in response to the Confidentiality warning. 
The Log On window displays. Make sure that your user name and domain are listed 
correctly in the log on dialog box.  

3 Enter your password and click on the OK button. 
Your local desktop displays. 

Accessing CONNECTIONS 
The CONNECTIONS application is made available to users in three different ways: 

Production 
Database 

The Production Database contains “live” data. This is the 
database that all workers use to record information in 
CONNECTIONS. 

Training Database The Training Database contains simulated data and allows you 
to practice functions necessary for your casework activities. It 
mirrors the functionality of the Production Database. The Training 
Database is used only for instructor-led training classes. 

Preview Application The Preview Application contains a “snapshot” of actual case 
data. Information entered into the Preview application does not 
carry over to the Production Database. 

The Preview Application provides the opportunity to preview 
changes and enhancements planned for the CONNECTIONS 
system. The Preview Application is available for a limited time 
when changes to the system are made. You will receive special 
notice when the Preview application becomes available. 

To distinguish between the Training Database and the Preview application, keep in mind that 
the Training Database contains simulated data, while the Preview application is a “snapshot” of 
actual case data. The Training Database allows you to practice functions necessary for your 
casework activities. 
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Using the CONNECTIONS Production Database, you can access your Assigned Workload from 
any CONNECTIONS workstation throughout New York State. All you need is a valid User ID 
and password to gain access to your workload. 

Your access to information in CONNECTIONS is restricted to what is necessary for the normal 
performance of your job responsibilities; this is accomplished by the assignment of a unique 
User ID to each worker. The User ID and password are the “keys” to access certain agency 
information. A worker’s User ID and password are also a form of identification; they link a 
worker to actions in the system. Workers are responsible for actions taken with their User ID 
and password. 

All workers in your agency must follow password standards established by OCFS/OFT. The 
following automated system controls support the password standards: 

• A password cannot be the same as the User ID. 
• Password length must be a minimum of eight (8) characters. 
• Maximum password age is 90 days. 
• After six (6) failed attempts, the system will lock the worker out of CONNECTIONS. 
• If a worker is locked out of the system based on password lock-out, the Security 

Coordinator must reset the password in order to permit that worker access to the 
system. 

In addition to the above controls, after 15 minutes of inactivity while logged into 
CONNECTIONS, the system locks the worker out. The worker must enter his/her password in 
order to log back in to the system. 

It is up to you to protect your password in order to prevent unauthorized access or misuse of 
information. Here are some ways to keep your password protected: 

• Make it difficult 
Select a password that is easy for you to remember, but difficult for others to guess. 
Don’t be stingy—make your password as long as possible (at least 8 characters and up 
to a maximum of 13 characters), in order to help reduce the likelihood of allowing 
someone to guess it. You cannot use all or part of your logon ID in your password, nor 
can you reuse any of your last 13 passwords. 

• Mix it up 
Your OCFS password must contain at least one uppercase letter, one lowercase letter 
and one number. CONNECTIONS users must never use symbols in their passwords. 

• Keep it to yourself 
Don’t share your password with others. Never display your password; if you need to 
write it down, don’t keep the information at your desk or anywhere it may be easily seen 
by others. 

• Embrace change 
You must change your password periodically—at least once every 90 days. If you think 
your password has been compromised, change it immediately. (Don’t forget to report the 
situation to your LAN/Security Administrator as soon as possible!) 

• Be yourself 
Use only your logon ID and password; never use a current or former co-worker’s ID or 
password. 
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If the AutoComplete window 
displays during the logon process, 

select the Don’t offer to remember 
any more passwords checkbox 

and click on the No button. 
 

CONNECTIONS resides on a centralized Citrix server. The Connections and other Citrix 
Applications icon on your local desktop opens the Connections and other Citrix Applications 
window, which contains icons of CONNECTIONS applications that are available to you based 
on your NT logon. When you double-click on one of these icons, your computer accesses the 
Citrix server and begins a “Citrix session.” The Citrix desktop displays, covering your local 
desktop and remaining open for the length of your Citrix session. The Citrix desktop also has an 
easily recognizable background. 

The CONNECTIONS icon displays on the Citrix desktop. Double-clicking the icon starts the 
application, opening a window on your desktop for it. The CONNECTIONS icon varies slightly, 
depending on the logon information you use (i.e., based on whether you opened a Citrix session 
for the Production Database, Training Database or Preview Application). 

When you log on to Citrix via the Connections Desktop 95 Percent icon, three icons display 
on the Citrix desktop: 

• Connections 
• Policy Library 
• CINPID (Data Warehouse; limited to designated users) 

The Task Bar at the bottom of the Citrix desktop provides a method of organizing the application 
windows that you have open in Citrix. You can have more than one application window open on 
your desktop at a time. Minimize a window by clicking on the Minimize button ( ). The 
minimized application window displays as a button on the Task Bar. This makes room for other 
windows you need to use at that moment. To re-open an application window, click on its button 
on the Task Bar; the application window displays as the active window, placing it “on top of” any 
other open windows. 

Clicking on the Start button (in the lower left corner of the Citrix desktop) displays the Start 
menu, which provides access to the Citrix Log Off procedure (see page 7 for details on this 
procedure). 
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Step-by-Step: 
Launching CONNECTIONS (Production) 

1 From your local desktop, double-click the 
Connections and other Citrix Applications icon. 
The Connections and other Citrix Applications 
window displays, containing icons of applications 
that are available to you based on your NT logon. 

 
If you are logged on to the 
system, always lock your 

computer when you leave your 
desk. This will help prevent 

unauthorized individuals from 
using your User ID and 

password to access 
CONNECTIONS.  

You can lock your computer by 
holding down the Ctrl+Alt+Del 

keys at the same time and 
clicking on the Lock Computer 

button. 

2 Double-click the Connections Desktop 95 Percent 
icon.  
A Confidentiality Warning message displays. 

3 Click on the OK button in response to the 
Confidentiality Warning. 
The Citrix desktop displays and your Citrix session 
begins. 

4 Double-click the Connections icon. 
When the CONNECTIONS Production Database 
has launched successfully, the CONNECTIONS 
Toolbar displays, reading: Production – 
CONNECTIONS Toolbar – <Your Name>. 
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Closing CONNECTIONS and Logging Off Your PC 
When you have finished your work in CONNECTIONS, you should close both CONNECTIONS 
and your Citrix session. This is best done as a two-step process: first close CONNECTIONS, 
then log off of Citrix. Doing so (as opposed to logging off of Citrix while CONNECTIONS is still 
open) reduces the likelihood of problems occurring during the log off procedure. 

At the end of your workday, it is important to log off your PC; if you completely shut down (turn 
off) your computer, it will not be able to receive any updates that may occur overnight. Leaving 
the computer logged off (but with the power still on) will enable it to receive these updates. 

 

 

Step-by-Step: 
Closing CONNECTIONS and Logging Off Your PC 

1 Click on the File menu (represented by the Globe 
icon [ ] in the upper left corner of the 
CONNECTIONS Toolbar) and select the Close 
command. 

 

Do not use the X button to close 
the CONNECTIONS Toolbar or 

the Citrix desktop. Doing so 
may tie up your Citrix session, 
resulting in an error message, 

which informs you that you have 
a disconnected 

CONNECTIONS session and to 
use the re-connect link on your 

browser to access it. 

2 Click on the Start button in the lower left corner of 
the Citrix desktop and select Log Off <User name> 
from the resulting menu. 
The following message displays: 
“Are you sure you want to log off?” 

3 Click on the Yes button. 
This does not log off your machine; it only ends your 
session with the Citrix server. Your local desktop 
displays. 

4 Close all applications still open on your local desktop. 

5 Click on the Start button and select the Shut down… command from the resulting 
menu. 
The Shut Down Windows dialog box displays. Click on the drop-down arrow and 
select Log off <user name>, if it is not already selected. 

6 Click on the OK button. 
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CONNECTIONS Security 
In order to protect the confidentiality and integrity of case data, 
access to information in CONNECTIONS is carefully controlled. 
A number of factors determine the information you can view or 
maintain in CONNECTIONS, including your job function, the 
cases to which you are assigned, your assigned role and your 
Business Function Profile (BFP). 

 
The information you are able to 
view and the tasks you are able 

to perform in the Training 
Database may not mirror what 

you are able to do in the 
Production Database. Contact 
your supervisor and/or Security 

Coordinator if you have 
questions regarding your 

security access. 

Your agency’s Security Coordinator is responsible for ensuring 
that appropriate physical, logical and procedural controls (such 
as locking your keyboard when you are away from your 
computer) are in place to preserve the security properties of 
confidentiality, integrity, availability and privacy of 
CONNECTIONS information. Information must be protected 
and classified based on security best practices as defined in 
the International Security Standard ISO/IEC 17799, A Code of 
Practice for Information Security Management. 

An agency may find it necessary to allow workers to complete their job functions outside of the 
office. When working from a remote location, the following security controls need to be 
considered and are not limited to: 

• the existing physical security of the remote location; 

• the communication security requirements; 

• the sensitivity of the information that will be accessed and transmitted; and 

• the threat of unauthorized access. 

Confidential information should not be stored on (nor transmitted from/to) portable computer 
devices. If workers must store or transmit confidential information, protective measures must be 
implemented. When using mobile commuting devices such as laptop computers, Personal 
Digital Assistants (PDAs) and cellular phones, special care should be taken to ensure that 
confidential information is not compromised. 

When traveling, CONNECTIONS staff using portable computers should not check these items in 
airline luggage systems. Confidential information should be removed prior to traveling; removing 
confidential information from portable computers should be done on a regular basis.  

Dial-up modems should not be connected to computer systems that are on a LAN or another 
internal communication system, unless approved by OCFS. Also, no wireless network or 
wireless access point should be installed without performing a risk assessment and obtaining 
appropriate written approval from the OCFS Information Security Officer. 

Software should never be installed without the approval of the OCFS Information Security 
Officer. Software security patches are installed by OFT. Computers should be left turned on (but 
logged off) so that security patches can be installed when users are not using their computers.  

Anti-virus software will protect against the vast majority of viruses and other vulnerabilities, but 
it’s not foolproof. Everyone has a responsibility to ensure that proper precautions are taken to 
protect the network and to ensure that viruses don’t get in or get spread. 
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There are also some security issues to keep in mind when contacting individuals, whether it is 
by telephone, cellular phone, fax or e-mail. 

Avoid using Internet, third party or wireless fax services to send or receive faxes containing 
confidential information. If it is necessary to send confidential information via fax, be sure to 
verify the phone number prior to sending the fax and contact the recipient to ensure the fax is 
picked up immediately. Also, avoid sending teleconference call-in numbers and passwords to a 
pager if sensitive information will be discussed in the conference; confirm that all participants 
are authorized to participate prior to starting any discussion.  

Precautions also need to be taken when exchanging information over the telephone. Take care 
that you are not overheard when discussing confidential matters on the telephone. You should 
avoid leaving sensitive or confidential messages on voicemail systems. Take extra precautions 
when using mobile devices in public areas outside of the workplace. Any use of wireless or 
cellular phones should be avoided when discussing sensitive or confidential information. 

Do not exchange confidential information over a messaging system unless authorized by the 
OCFS Information Security Officer, after a formal risk assessment of the situation has been 
performed. No external public Instant Messaging, Teamrooms and Conferencing services 
should be used to conduct business unless authorized in writing by the OCFS Information 
Security Officer. 

Your Security Coordinator may need to monitor workers’ activity on the system, since it is the 
Security Coordinator’s responsibility to ensure that all security processes and procedures are 
followed. Do not have any expectation of privacy in the information stored in or sent through the 
OCFS network, including e-mail, because your Security Coordinator and OCFS/OFT reserve 
the right to monitor or search any system at all times. You are notified of this each time you log 
on to the network (a privacy message displays). 

As a CONNECTIONS user you must understand your role and responsibility regarding the 
security of CONNECTIONS information. You have an obligation to protect and preserve all 
information in a consistent and reliable manner. 

All CONNECTIONS users receive security profiles which determine the windows or types of 
information they can open and view, as well as which windows they can modify or “maintain.” In 
CONNECTIONS, each person’s security profile is called a Business Function Profile (BFP). 
Each worker has only one BFP. Each BFP is comprised of one or more Business Functions, 
which in turn are comprised of one or more Security Attributes. Your BFP is based on the tasks 
you are responsible for performing and the level of access to records needed to complete those 
tasks. Your BFP may include multiple business functions based on your responsibilities. 

Security coordinators at the local district and voluntary agency level assign appropriate 
Business Functions to each staff person in their offices, creating an individual Business 
Function Profile for each worker. A few examples of Business Functions that might be included 
in a local district worker’s Business Function Profile are CREATE FSI, ENTER PROG NOTE 
and CASE/PERS SRCH. Workers with the UNIT SUM ACCESS Business Function in their 
respective BFPs are able to review the Assigned Workloads of the staff members in their units. 
(Typically, this Business Function would be included in the BFP of a Unit Approver.) 

If you are working on a stage and cannot view or modify information that relates to your job 
responsibilities, you should review your BFP with your supervisor to make sure the Business 
Functions included in your BFP are adequate for the work you are doing. CONNECTIONS users 
are not allowed to prove a suspected weakness; in other words, workers should not attempt to 
find work-arounds or bugs in the system. All CONNECTIONS users should be aware of the 
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procedure for reporting security incidents that may have an impact on the security of 
information. You must report any incidents to your appropriate supervisor and your agency’s 
Security Coordinator.  

A special Business Function, VIEW SECURITY, allows you to review your BFP in 
CONNECTIONS to see the business functions assigned to you. If your BFP indicates that you 
do not have security access for a task you need to complete, speak with your supervisor and/or 
Security Coordinator. 

 

Step-by-Step: 
Viewing Your Business Function Profile 

1 Click on the Options menu on the CONNECTIONS Toolbar and select the Security 
command. 
The Security sub-menu displays. 

2 Click on the View Staff Security command. 
The Staff Search Criteria window displays. 

3 Type your last name into the Last Name field. 

4 Click on the Search button. 
The Staff List displays. 

5 Click on your name to select it from the Staff List. 

6 Click on the OK button. 
The Staff Security window displays. The Business Functions field on this window 
contains the available Business Functions. 

7 The Business Functions assigned to you are identified with red checkmarks. Use the 
vertical scroll bar inside the Business Functions field to view the entire list. 
To see the Business Functions assigned to you without scrolling through the entire 
list, click on the Selected Business Functions Only checkbox. 

8 To close the Staff Security window, click on the Cancel button. 
The CONNECTIONS Toolbar displays. 
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Module 1: 
Person Maintenance 

As you gather information on people associated with a case, you may obtain new information or 
information that needs to be corrected. The Maintain Person task in CONNECTIONS provides 
access to a number of windows where you can record this information. Local districts, New York 
State offices and other agencies rely on CONNECTIONS users to record all relevant information 
discovered, so that others can make use of that information in the future. 

In this module you will learn how to add and correct the information on persons associated with 
a case. 

By the end of this module, you will be able to: 

• change person demographics; 

• maintain primary address and phone information; 

• remove and unrelated persons from cases and stages; and 

• merge and split person records in the database. 

CONNECTIONS Data Maintenance Step-by-Step Guide Page 11 
Training for CPS Caseworkers  v1.1 (rev 06/13/2006) 



Maintaining Information About People in a Case 
During the course of an investigation, you will gather information about people associated with 
the case. When that information differs from what is already contained in the CONNECTIONS 
database, you can update records by recording the new 
information via the Maintain Person task. Use this function to 
record demographic, address and phone information. In 
CONNECTIONS, a person may have only one valid primary 
name, address or telephone number at a time. S/he may 
however, have a number of secondary addresses or telephone 
numbers. When you change the primary name, address or 
telephone number, the previously listed primary information is 
automatically end-dated. 

 

On the Person Detail window, 
you’ll see an Effective Date 
field and a Search button. 
Use these fields to search 
for information maintained 

in CONNECTIONS as 
of a specific date: 

1.  In the Effective Date field, 
enter the date for which you 
would like information. 

2.  Press the Tab key on your 
keyboard to exit the Date 
field. 

3.  Click on the Search button. 
The information from the 
earlier date displays in the 
fields in the window. 

4.  To return to the current 
information, click on the 
Reset button. 

Because of the need to maintain historical information in 
CONNECTIONS, you cannot delete or modify existing names, 
addresses or phone numbers. Information that was once 
correct, but is now outdated, is noted in CONNECTIONS by its 
end-date. If there is information in a record that was never 
correct, indicate that by marking the information as Invalid. 

Changing Person Demographics 
Use the Person Detail window to record a person’s sex, 
ethnicity, marital status, primary language, date of birth (DOB), 
age and, if applicable, date of death (DOD) and reason. The 
Investigation Conclusion cannot be saved and submitted 
without DOB information; if you attempt to Save and Submit 
without this information, the following message displays: “Each 
principal in the Investigation must have an exact or estimated 
DOB.” 

 

Step-by-Step: 
Changing Person Demographics 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on an INV stage to select it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Maintain Person task. 

5 Click on the List… button. 
The Person List displays for the selected stage. 
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6 Click on the name of the person whose record you want to update. 
(If you are recording information for the first time, see the “Case Maintenance” 
module in this guide for details about adding or relating persons.) 

7 Click on the Detail… button. 
The Person Detail window opens for the selected 
individual. 

 
To record an age in the Age 

field, enter a date of birth in the 
DOB field. CONNECTIONS 
calculates the age from DOB 

information. If you do not know 
the exact date of birth, enter an 
approximate date and select the 

Approx DOB checkbox. 

8 Click on the drop-down arrow for each applicable 
field and select from each resulting list. If a field 
does not have a drop-down arrow, type directly into 
the field. 

9 Click on the Save button. 
The Person List displays. 

10 Click on the Close button. 
The Task List displays. 

11 Click on the Close button to close the Task List. 
The Assigned Workload displays. 

12 Click on the Close button. 
The CONNECTIONS Toolbar displays. 
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Adding or Correcting a Person’s Name or Alias 
In CONNECTIONS, a person can have both a primary name 
and a legal name, or the name s/he is now using, and any 
number of non-primary names, or AKA’s. An AKA could be an 
alias or street name, Common Law assumed name, maiden 
name, or former name. 

Use the A.K.A. Name List/Detail window to add or maintain 
multiple names for a person. A person can have only one 
primary name, so when you add a new primary name, 
CONNECTIONS automatically end-dates the existing one. 
Because of the need to maintain accurate historical information 
in CONNECTIONS, you should never delete names. If a name 
once was (but no longer is) used for a person, that name needs 
to be end-dated. Names should be invalidated only if they were 
never correct for the person. 

 

Step-by-Step: 
Adding or Correcting a Person’s Name/Alias 

1 Open the Person List for the selected stage. 
See Steps 1-6 on Changing Person Demographics on page 12. 

2 Click on the Options menu and select A.K.A. Name List/Detail… 
The A.K.A. Name List/Detail window displays for the selected person. 

3 To change the primary name or add an alias, type the new information in the Name 
Information section in the bottom half of the window. 

 

Do not invalidate a misspelled 
name if it is one that is a 
common misspelling (for 

example, Stephen, Steven, 
Steve or Stephan). This 

increases the chance of the 
name appearing as a match 
in searches. Only invalidate 

misspelled names if 
they are clearly wrong, 
like “Gelen” for “Helen.” 

 
There can be only one current 
primary name for an individual. 
The primary name is always the 

first name on the list. When a 
new primary name is added 
CONNECTIONS “end-dates” 
the existing primary name. 

4 If the new name is the primary name, click on the 
Primary checkbox to select it. 

5 Click on the Add button. 
The new name is added to the list section at the top 
of the window and identified as primary (if 
appropriate). CONNECTIONS automatically end-
dates any existing primary name. 

6 If any name in the list section is invalid, highlight that 
name, select the Invalid checkbox and click on the 
Modify button. 
The name is marked as invalid. 

7 Click on the Save button. 
The Person List displays. If you changed the primary name for the person, the 
Person List reflects that change. 

8 Click on the Close button. 
The Task List displays. 

9 Click on the Close button. 
The Assigned Workload displays. 
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Adding or Correcting Person Identifier Numbers 
CONNECTIONS enables you to record various identification numbers, such as a Social Security 
Number (SSN) or WMS Client Identification Number (CIN). Person identifiers are very helpful in 
distinguishing persons who may have the same name or other similar demographic information. 
Person identifiers help CONNECTIONS users maintain data integrity in the system. This 
information is recorded in the Person Identifiers window. 

 

Step-by-Step: 
Adding or Correcting a Person Identifier Number 

1 Open the Person List for the selected stage. 
See Steps 1-6 on Changing Person Demographics on page 12. 

2 Click on the Options menu and select Person Identifiers. 
The Person Identifiers window displays for the selected person. 

3 Select an ID type by clicking on the drop-down arrow in the Type field and selecting 
from the resulting list. 
If you choose “Other” as the type, you must enter 
Comments.  

4 Type the ID number into the Number field (the 
number will be pink). 
Press the Tab key or click in the Comments field to 
record comments. Type directly into the field. 

5 Click on the Add button. 
The new identifier displays in the list section at the 
top of the window. 

6 Click on the Clear button to add another identifier. 

7 To delete an identifier, click on the identifier from the 
list section and then click on the Delete button. 
The following message displays: “Are you sure you want to delete this record?”  
Click on the Yes button to delete the identifier. Click on the No button to cancel the 
deletion. 

 
Person identifier numbers are 
numbers that originate outside 
of the CONNECTIONS system 
(e.g., SSN, WMS, CIN). They 

are not the same as the 
CONNECTIONS-generated 

Person Identification Number 
(PID). 

8 Click on the Save button. 
The changes are saved and the Person List displays. 

9 Click on the Close button. 
The Task List displays. 

10 Click on the Close button. 
The Assigned Workload displays. 
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Maintaining Primary Address and Phone 

Changing Primary Address and Phone Information for Multiple Persons 
When a family moves to a new address or the phone number changes, you need to add the 
new information in CONNECTIONS. Whenever a new primary address and/or phone number is 
added, CONNECTIONS automatically end-dates the existing primary address and/or phone 
number. If you notice an address or phone number in CONNECTIONS that was never accurate, 
invalidate it. 

The caseworker may update or add address/phone information for multiple persons in an 
Investigative stage rather than updating one person at a time. This function is accessed through 
the Maintain Primary Address and Phone task on the Task List for the selected stage. 

 

Step-by-Step: 
Changing Primary Address and Phone for Multiple Persons 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on an INV stage to select it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Maintain Primary Address and Phone task. 

5 Click on the Detail… button. 
The Maintain Primary Address and Phone window displays. 

6 Record the new information in the fields at the top of the window. 
The Type field is required. 

7 Click on the Validate button to perform address validation. 
All addresses must be validated. If there is a discrepancy between the validated 
address and the address that was recorded, a message displays, showing both 
addresses for comparison.  
Please Note: If a New York City address was recorded and the CD was not 
retrieved, the following message displays: “Community District Could not be 
Populated.” 

8 You must choose either to Accept or Reject the validated address. Click on the 
Accept button to replace the recorded address with the validated address; or click 
on the Reject button to use the recorded address. 

9 To link this address to one or more individuals listed in the lower section, click on the 
box to the left of each applicable individual. To select more than one individual, press 
and hold the Ctrl key on the keyboard while clicking on the box to the left of the 
name. 
Selected individuals highlight. 

Page 16 CONNECTIONS Data Maintenance Step-by-Step Guide  
v1.1 (rev 06/13/2006) Training for CPS Caseworkers 



 

10 Click on the Save button. 
The Maintain Primary Address and Phone window refreshes and displays with the 
new address.  

11 Click on the Cancel button. 
The Task List displays. 

12 Click on the Close button. 
The Assigned Workload displays. 

Changing Address and Phone Information for an Individual 
Address and phone information can be maintained for individuals using one of the following 
methods: 

• Manually entering the new address and/or phone information 

• Linking an individual to a pre-existing case address 

If a person is being related or added to a stage, but that individual does not reside in the 
household (e.g., a biological parent who does not live with the child), it is usually more efficient 
to maintain the address and/or phone information for this individual in the Person Detail window. 

If a person who lives in the household is being related or added to a stage, the Maintain Primary 
Address and Phone window enables the worker to maintain this information efficiently, while 
reducing the likelihood of data entry error. The Maintain Primary Address and Phone window 
also provides an efficient method for updating this information for several individuals in a 
household (e.g., when the family moves to a new address). 

 

Step-by-Step: 
Adding or Correcting a Person’s Phone Number 

1 Open the Person List for the selected stage. 
See Steps 1-6 on Changing Person Demographics on page 12.  

2 Click on the Options menu and select Phone List/Detail…. 
The Phone List/Detail window displays for the selected person. 

3 Select a phone number type (e.g., residential, business) by clicking on the drop-
down arrow for the Type field and selecting from the resulting list. 

4 Enter the new number in the Number field. 

5 If this is the individual’s primary phone number, select the Primary checkbox. 

6 Click on the Add button. 
The new phone number information is added to the list section at the top of the 
window. If you added a new primary phone number, CONNECTIONS automatically 
end-dates the existing primary number. 
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7 Click on the Save button. 
The Person List displays. 

 
You can update multiple records 

on this window before saving. 

8 Click on the Close button. 
The Task List displays. 

9 Click on the Close button. 
The Assigned Workload displays. 

When a family moves, or you add a new person, you need to add the new address in 
CONNECTIONS. If you indicate that the new address is the primary one, CONNECTIONS 
automatically end-dates any existing primary address. If you notice an address in 
CONNECTIONS that was never accurate, you “invalidate” the address. 

 

Step-by-Step: 
Adding or Correcting a Person’s Address 

1 Open the Person List for the selected stage. 
See Steps 1-6 on Changing Person Demographics on page 12.  

2 Click on the Options menu and select Address List/Detail…. 

3 Record the new information in the appropriate fields. 
The Type field is required. 

4 Click on the Validate button to perform address validation. 
All addresses must be validated. If there is a discrepancy between the validated 
address and the address that was recorded, a Replace with CODE-1 validated 
address? window displays. You must choose either to accept or reject the validated 
address. Click on the Yes button to replace the recorded address with the validated 
address, or click on the No button to use the recorded address. 
Please Note: If a New York City address was entered and the CD was not retrieved, 
the following message displays: “Community District Could not be Populated” 

5 Click on the Add button. 
The Save button enables. 

6 Click on the Save button. 
The Person List displays. 

7 Click on the Close button. 
The Task List displays. 

8 Click on the Close button. 
The Assigned Workload displays. 
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Step-by-Step: 
Invalidating an Address or Phone Number 

1 Open the Person List for the selected stage. 
See Steps 1-6 on Changing Person Demographics on page 12.  

2 Click on the Options menu and select Phone 
List/Detail… or Address List/Detail…. 
The Phone or Address List/Detail window displays for 
the selected person.  

The only time an address or 
phone number is invalidated is if 

it was never accurate. 

3 From the list section at the top of the window, click on 
the phone number or address that needs to be 
invalidated. 
The information displays in the fields in the detail 
section of the window. 

4 Click on the Invalid checkbox. 

5 Click on the Modify button. 
The phone number or address is recorded as Invalid and is stored for historical 
purposes. A red checkmark in the INV column denotes that the phone number or 
address has been invalidated. 

6 Click on the Save button. 
The Person List displays. 

7 Click on the Close button. 
The Task List displays. 

8 Click on the Close button. 
The Assigned Workload displays. 
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Linking an Individual to a Pre-existing Case Address  
If someone moves into the household, that individual needs to be added in CONNECTIONS and 
linked to the case address. This is done most efficiently by using the Maintain Primary 
Address and Phone task. 

 

Step-by-Step: 
Linking an Individual to a Pre-existing Case Address 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on an INV stage to select it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Maintain Primary Address and Phone task. 

5 Click on the Detail… button. 
The Maintain Primary Address and Phone window displays. 

6 Select a person with the correct address from the list in the lower section of the 
window by clicking on any field in that person’s row. 
A black arrow indicates the person selected. 
If the person has not been added to the stage yet or 
the address field is blank for the selected person, 
s/he needs to be added before this function can be 
utilized. 

 
Workers can exit the Multiple 

Primary Address/Phone 
Maintenance window without 

saving at any time by clicking on 
the Cancel button or selecting 

Cancel from the File menu. 

7 Click with the right mouse button. A menu displays 
with the following commands:  

• Use Primary Address 
• Use Primary Phone 
• Use Both Address and Phone 

8 Click to select a command from the menu. 
The Address and/or Phone information (depending on the command you selected) 
displays in the appropriate fields. This information can be modified if it is not 
applicable to the person. 

9 If you select Use Primary Address or Use Both Address and Phone from the 
menu, click on the Validate button to perform address validation. 
All addresses must be validated. If there is a discrepancy between the validated 
address and the address that was recorded, an address validation window displays 
with the recorded address and the validated address. Click on the Accept button to 
replace the recorded address with the validated address, or click on the Reject 
button to use the recorded address. 
Please Note: If a New York City address was entered and the CD was not retrieved, 
the following message displays: “Community District Could not be Populated.” 
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10 To link this address to one or more individuals listed in the lower section, click on the 
box to the left of an individual’s name. To select more than one individual, press and 
hold the Ctrl key while clicking on the box to the left of the person’s name. 
Selected individuals highlight. 

11 Click on the Save button. 
The Maintain Primary Address and Phone window refreshes and displays with the 
modifications. You can make additional changes to this window if necessary. 

12 Click on the Cancel button to close the Maintain Primary Address and Phone 
window. 
The Task List displays. 

13 Click on the Close button. 
The Assigned Workload displays. 

Person Reported in Error 
During the course of an investigation, the caseworker may 
determine that a person should never have been associated 
with the stage; the individual was “reported in error.” 

For example, the reporter tells the SCR Intake worker that four 
children reside in the household, including a teenager named 
Tommy and a child named Mina. The reporter has never seen 
Mina, but has heard the mother yelling at her and threatening 
to beat her. When the local district caseworker visits the home 
during the investigation, she learns that only two children 
reside in the household. Tommy is the 18-year-old delivery boy for the local grocery store and 
Mina is the family’s dog. Both Mina and Tommy would be considered “Reported in Error.” In 
addition, since Tommy is at least 18 years old, he is entitled to receive certain information, 
which is limited to the report itself and the portion of the case record that confirms he was 
reported in error. 

 

Changing a person’s role to 
“Reported in Error” is a 
corrective process only. 

If a person was reported in error during the Intake stage of a case, that person’s role can be 
changed to “Reported in Error” during the Investigation stage. Only the Primary worker, 
Secondary worker and Case Manager can select this new role – provided they have the MAINT 
REPT ERR Business Function. In addition, the Unit Approver in the unit of the Primary worker, 
Secondary worker or Case Manager (or someone with a role above that of the Unit Approver) 
can select the new role if they have the MAINT REPT ERR and UNIT SUM ACCESS Business 
Functions. 
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In order to change a person’s role to “Reported in Error,” all of the following conditions must 
also be met: 

• The person must have been reported during the Intake stage. 

• The person cannot be associated with any substantiated allegations. (The allegation 
details must be completed prior to changing the person’s role to “Reported in Error.”) 

• There must be at least one other allegation which does not involve the person whose 
role is being changed to “Reported in Error.” 

• The worker’s BFP must include the MAINT REPT ERR Business Function. (If the 
worker is a Unit Approver or someone with a role above that of the Unit Approver, 
the BFP must also include the UNIT SUM ACCESS Business Function.) 

Pre-existing Notification events (e.g., Notice of Existence) generated for this person do not 
prevent changing the role to “Reported in Error.” The district is responsible for sending manually 
generated letters notifying the person of the role change. Once the change is complete, the 
following notifications can no longer be system-generated for the person whose role was 
changed: Notice of Existence, Notice of Indication, IAB 
Notification Letter, IAB Indicated Letter and IAB Unfounded 
Letter. 

 
NYC Only: If a High Priority 

Factor (HPF) is calculated for 
the Intake stage due to this 

person’s role—and changing 
his/her role during the 

Investigation stage means the 
HPF is no longer in effect—the 
HPF no longer populates on the 

Assigned Workload when the 
HPFs are recalculated.  

This type of report would still be 
considered High Priority, 
however, because it was 

designated as such at Intake. 

The allegations associated with this person are deleted when 
the change is complete. A recalculation of overall roles and 
determination occurs when a person’s role is changed to 
“Reported in Error.” 

Changing a person’s role to “Reported in Error” changes how 
and where that person is listed in CONNECTIONS: 

• “XE” displays in the Role column for that person on 
the Person List. 

• If a person’s only role in a case is “Reported in 
Error,” that individual’s name does not display on the 
Case Composition window. 

• The person’s name still returns in a person search. 

 

Step-by-Step: 
Changing a Person’s Role to “Reported in Error” 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the stage containing the person whose role is to be changed. 
The Tasks… button enables.  

3 Click on the Tasks… button. 
The Task List displays. 
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4 Click on the Maintain Person task. 
The List… button enables. 

5 Click on the List… button. 
The Person List displays. 

6 Select the person whose role is being changed. 

7 Click on the Detail… button. 
The Person Detail window displays. 

8 Click on the drop-down arrow for the Role field and 
select Reported in Error from the resulting list. 

9 Click on the Save button. 
The following message displays: 
“Unsubstantiated/Undetermined allegations will be 
deleted. Continue?” 

10 Click on the Yes button. 
The Person List displays with the updated information. Note that “XE” displays in the 
Role column. 

11 Click on the Close button. 
The Task List displays. 

Person Unrelate 
The Person Unrelate function enables designated workers to 
Unrelate an individual who was related in error during the Intake 
stage. This function is performed in an open Investigation stage 
from the Person List. 

When a Person Unrelate is performed, the misrelated person 
(and the information associated with that individual) no longer 
appears in the Intake or other associated stages. A new person 
record with a new Person ID (PID) is created in the 
CONNECTIONS database using the information reported at Intake. 

In order to perform a Person Unrelate, the worker must: 
• be the Primary worker, Secondary worker or Case Manager; or 
• be the Unit Approver or have a role above that of the Unit Approver in the unit of the 

Primary worker, Secondary worker or Case Manager; or 
• have the ACCESS ALL DIST and CASE/PERS SRCH Business Functions (allowing 

access through a Case Search). 

In order to maintain accurate data for the person, workers are responsible for correcting 
necessary demographic information prior to performing a Person Unrelate. Performing a Person 
Unrelate changes a person’s role. If the individual received a notice prior to the Unrelate, the 
local district needs to send a new notice with the correct information. Notices also need to be 
sent whenever a new subject or person over 18 is added to a stage. 

 

If the person was not reported 
during Intake, the following 

message displays: 
“Person not in Intake. Cannot 

change role to  
Reported in Error.” 

If no other allegations are 
associated with another person, 
the following message displays: 

“A subject and MA/AB child 
must remain. Cannot change to 

Reported in Error.” 

 

Person Unrelate is a different 
function than Person Split, 

which is the process used to 
split person records that were 

merged in error. 
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1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the appropriate stage by clicking on it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Maintain Person task. 
The List… button enables. 

5 Click on the List… button. 
The Person List displays. 

6 Click to select the person to be unrelated. 

7 Click on the Options menu and select the Person 
Unrelate… command.  
See the tip box at right for warnings and error 
messages that may display. 
Once you have responded to any warnings, the 
following message displays. “Are you sure that you 
want to unrelate this person?” 

8 Click on the Yes button to complete the Person 
Unrelate process. 
The Person List displays with a “U” in the Sch 
column. 
To return to the Person List without performing the 
Person Unrelate, click on the No button. 

9 Click on the Close button to close the Person List. 
The Task List displays. 

10 Click on the Close button to close the Task List. 
The Assigned Workload displays. 

An Unrelate event is created for the associated Investigation stage. The following information 
displays in the Description column on the Event List for such an event:  
“<PID> was unrelated from <PID>.” 

An Alert is also generated to the Staff To-Do List of every worker assigned to an open stage that 
involves the misrelated person. The alert notifies the worker that a Person Unrelate occurred: 
“<Name> (<PID>) was unrelated from <Stage Name> (<Stage ID>).” 

Once the Person Unrelate is complete, “U” displays in the Sch column on the Case List, 
signifying that an unrelate has occurred. These changes are also reflected on the Person Data 
Report and the Intake/IRI Report. 

 

Step-by-Step: 
Unrelating a Person 

 
Person Unrelate 

Warnings and Error 
Messages 

If the person selected was not 
reported during Intake, the 

following message displays: 
“Person not in Intake. Cannot 

Unrelate. Choose Remove 
Person – Added in Error.” 

When demographic information 
for the person was changed 

after the date of the Intake, the 
following message displays: 
“Changes made to Person in 

this stage should be reset 
before continuing.” 

If the person is associated with 
another CONNECTIONS event 
(e.g., Notice of Existence), the 
following message displays: 

“Events for this person 
in this stage will be invalidated! 

Continue?” 
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Remove Person – Added in Error 
The Remove Person – Added in Error function enables 
designated workers to remove an individual who was added in 
error during an Investigation or ARI stage. This function is 
performed in an open Investigation stage from the Person List. 
This function cannot be performed if the person to be removed 
was reported at Intake or named in an allegation. 

In order to perform the Remove Person – Added in Error 
function, the worker must: 

• be the Primary worker, Secondary worker or Case Manager; or 
• be the Unit Approver or have a role above that of the Unit Approver in the unit of the 

Primary worker, Secondary worker or Case Manager; or 
• have the ACCESS ALL DIST and CASE/PERS SRCH Business Functions (allowing 

access through a Case Search). 

In order to maintain accurate data for the person, workers are responsible for making necessary 
demographic changes prior to performing the Remove Person – Added in Error function. For 
example, if the person’s age was changed from 45 to 35 after the person was added to the 
stage, the worker must correct the age to restore the original information.  

The example below illustrates a situation in which the “Remove Person – Added in Error” 
function is needed: 

A caseworker has an INV stage open for the “Smith” case in CONNECTIONS. The 
worker inadvertently adds a person from the “Jones” case to the “Smith” case. 

 

Step-by-Step: 
Removing a Person Who Was Added in Error 

1 Click on the WORK button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 

2 Select the appropriate stage by clicking on it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Maintain Person task. 
The List… button enables. 

5 Click on the List… button. 
The Person List displays. 

6 Select the person to be removed. 

 
The “Remove Person – Added 

in Error” function is a 
corrective process only. 

 
If any demographic information 

has been changed since the 
person was added to the stage, 
the following message displays: 

“Changes made to Person in 
this stage should be reset 

before continuing.” 

If the person is associated with 
another CONNECTIONS event 
(e.g., Notice of Existence), the 
following message displays: 

“Events for this person 
in this stage will be invalidated! 

Continue?” 
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7 Click on the Options menu and select Remove Person – Added in Error. 
The following message displays: “Are you sure you want to remove the person 
Added in Error?” 

8 Click on the Yes button to complete the Remove Person – Added in Error process. 
The Person List is updated and the removed person’s name no longer displays. 
To return to the Person List without removing the person, click on the No button. 

9 Click on the Close button.  
The Task List displays. 

10 Click on the Close button to close the Task List. 
The Assigned Workload displays. 



 

Merge and Split Functions to Correct Duplicate and 
Combined Records 

 

WARNING! 

Since it is not always possible 
to correct errors you may make 

when merging and splitting 
records, be sure to: 

1 Talk with your supervisor 
before proceeding. 

2 Be careful when merging 
and splitting records. 

CONNECTIONS information needs to be maintained in a 
secure, accurate and reliable manner, as well as readily 
available for use by workers needing information. The process 
of merging and splitting records is complicated and cannot 
always be fully undone. Notify your supervisor if you notice 
records that should be merged or split so that necessary 
corrections can be made. 

The individual authorized to perform the Person Merge/Split 
function is subject to local district policy and procedure. This 
task may not fall under the scope of the individual caseworker’s 
responsibilities. In order to perform the Person Merge/Split 
function, the worker’s BFP must include the appropriate 
Business Functions. 

In your work with CONNECTIONS, you may come upon multiple records for the same person, 
or records for two separate persons that have been accidentally combined into one. 

Duplicate records can be created during Intake if an Intake worker has limited or unknown 
demographics on a person and therefore, cannot relate that person to an already existing 
person in CONNECTIONS. Duplicates can also result if a caseworker misses a potential match 
during a Person Search; the worker would then add this person to the case rather than relating 
him/her to the existing person in the system. The opposite situation—accidentally combined 
records—can result if a caseworker merges records for two individuals who seem to be the 
same person but in fact, are not. Regardless of the reason, duplicate records and 
accidentally combined records pose problems for accurate case management and need 
to be corrected once they are identified. 

Duplicate and accidentally combined records are corrected in CONNECTIONS with the Merge 
and Split functions. A Merge joins two separate Person IDs or Case IDs into the same record. A 
Split separates cases or people that were merged in error. Person Merges and Splits occur 
immediately in CONNECTIONS; an overnight batch update is not required. 

The ability to perform Merge/Split functions is dependent on the worker’s role and level of 
security access. In order to perform a Person Merge or Split in a closed stage, the worker must 
have the MERGE/SPLIT Business Function and: 

• be the historical Primary worker, Secondary worker or Case Manager; or 
• be the historical Unit Approver or have a role above that of the Unit Approver in the 

unit of the Primary worker or Secondary worker and have the CASE/PERS SRCH 
Business Function; or 

• have the ACCESS ALL DIST and CASE/PERS SRCH Business Functions (allowing 
access through a case search). 

To perform a Person Merge or Split in an open stage, the worker must have the MERGE/SPLIT 
Business Function. The worker must also meet one of the above criteria or: 

• be the Unit Approver or have a role above that of the Unit Approver in the unit of the 
Primary worker, Secondary worker or Case Manager and have the UNIT SUM 
ACCESS Business Function. 
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Person Merge Function 
Before completing a Person Merge, a decision must be made 
regarding which person will be carried forward to further stages 
(the Merged Forward Person) and which person will be “retired” 
after the Merge (the Merged Closed Person). The Merged 
Forward Person should be the person with the most history. 
This is generally the one with the Person ID number that has 
been in the system longer. It is important to understand how the 
Merge affects each of these roles in CONNECTIONS. 

 

When merging two 
Person IDs: 

• Their age difference should 
be within five years. 

• If the Merged Closed 
Person is involved in an 
open Intake, the following 
message displays: “The 
closed person is in open 
stages. Merge with extreme 
caution. Continue?” 

The Merged Forward Person: 
• is carried forward to subsequent CONNECTIONS 

stages; 
• appears on the Person List in the current open 

stage, any closed stages and any future stages; and  
• is identified by a checkmark in the M/S column of the 

Person List. 

The Merged Closed Person: 
• is “retired” after the Merge and information of the new Merged Forward Person is 

used in all open and closed stages; 
• cannot be related to a new stage; and 
• cannot be involved in future system events. 

A Person Merge results in the following system changes: 
• The Merge List on the Person Merge/Split window is updated to reflect the action 

taken. 
• The Merged Forward Person inherits the demographics that have been selected 

and appear in all stages. 
• The Merged Closed Person is no longer linked to any of the stages that were open 

at the time of the Merge. These are now linked to the Merged Forward Person. 
• System-generated Alert To-Do’s are sent to the Staff To-Do List of the Primary and 

Secondary workers for any open stages that involve the Merged Forward Person or 
Merged Closed Person. 

A Person Split results in the following system changes: 
• The previously Merged Closed Person becomes active again in the database, but is 

not re-associated with any stages. 
• The previously Merged Closed Person’s pre-merge demographics remain available 

in CONNECTIONS. 
• The events/activities associated with the reactivated person (and approved prior to 

the Merge) require data maintenance to again be associated with that person. 
• Events that occurred while the Merge was in effect are not associated with the 

reactivated person. 
• System-generated To-Do’s are sent to workers assigned to open stages associated 

with the previously merged person. 
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The Person Forward Selection Window 

 

Person Merge Warnings and 
Error Messages: 

When completing a Person 
Merge, you may see warnings 

and/or error messages. 
Warnings do not prevent you 
from completing a Merge, but 

error messages do. 

Reasons for Warnings: 

• Both persons must be the 
same sex (if it is recorded). 

• Both people must have a 
DOB that is within 5 years 
(if recorded). 

• One of the persons is 
involved in a fatality report. 

• The Merged Closed Person 
is in an open Intake or 
Investigation stage. 

Reasons for Error Messages: 

• Social Security numbers do 
not match. 

• Medicaid number does not 
match. 

• Entered ID is not found, 
verify ID. 

• Services CIN must match. 

• NYC Non-Service (NS) 
CIN’s must match 
(NYC only). 

• Merge will cause person to 
be a subject and MA/AB 
child in the same 
Investigation Stage. 

• The ID Person entered has 
the status of person closed 
from a prior Merge. 

The Person Forward Selection window enables you to select 
specific person information that is applied to the Person Forward. 
The type of information you select—and which person you select 
it from—affects the information that is retained for the Person 
Forward. 

If you select information from the Person Closed, the primary 
information for the Person Forward is end-dated and the 
information from the Person Closed is copied to the primary 
record. 

Valid person identifier, Language and Religion information is 
retained from the Person Forward, unless the field is blank. If the 
Person Forward does not have this information recorded, the 
information from the Person Closed is copied to the Person 
Forward. 

If you have been given approval to merge person records, 
perform the following steps to complete this task. 

 

Step-by-Step: 
Completing a Person Merge within the 
Assigned Workload 

1 From the Assigned Workload, select the stage 
containing the person information that requires 
merging. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays for the selected stage. 

3 Click on the Maintain Person task. 
The List… button enables. 

4 Click on the List… button. 
The Person List displays. 

5 Click on the name of the person to be merged. 

6 Click on the Options menu and select Person 
Merge/Split. 
The Person Merge/Split window displays. The 
highlighted name from the Person List pre-fills in the 
Merged Persons Closed section. 

7 Enter the Person ID of the Merged Forward Person. 
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8 Click on the Validate button. 
The system checks for an open case and a valid Person ID. When the check is 
complete, the Merge button enables. 
 
NOTE: Several warning or error messages may display after selecting the Validate 
button. Below are some of the most common messages: 
Error Message: “The ID entered is not found. Verify IDs.” 
Warning Message: “The age difference is greater than 5 years.” 
Warning Message: “The Person may not have the same gender.” 
Click on the Close button. 
The Person Merge/Split window displays. For error messages the Merge button is 
disabled. For warning messages the Merge button is 
enabled. 

 
If you determine that the person 
selected to be merged closed 

should, in fact, be merged 
forward, use the Switch 

function: 

1 Click on the Options menu. 

2 Click on the Switch 
command. 

NOTE: 
If you attempt to use the Switch 

function to perform a Person 
Merge between a person in an 

Investigation stage and a 
person in an unprogressed 

Intake stage, the following error 
message displays: 

”The Person Closed is involved 
in an open intake.” 

Under these circumstances, you 
cannot use the Switch function. 
You need to enter the Person ID 
manually from the unprogressed 

Intake stage into the Person 
Forward field to perform the 

Person Merge. 

9 Click on the Merge button. 
If the person to be closed is in an open stage, the 
following message displays: 
“The closed person is in open stages. Merge with 
extreme caution. Continue?” 

10 Click on the Yes button.  
The following message displays:  
“Merge ID# into ID#?” 
The first ID number listed is for the Merged Closed 
Person. The second ID number is for the Merged 
Forward Person.  
NOTE: If you realize that you have made a mistake 
in selecting your persons, click on the No button. 
The Person Merge/Split window remains open until 
you close it. 

11 Click on the Yes button. 
The Person Forward Selection window displays with 
the following information for both the Person 
Forward and the Person Closed: 

• Full Primary Name (First, Middle, Last, 
Suffix) 

• Sex 
• Ethnicity 
• Race 
• Marital Status 
• DOB (including Approximate indicator, 

if applicable) 
• DOD (including Approximate indicator and reason, if applicable) 
• Primary Address 
• Primary Phone 
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12 Select information from the Person Forward Selection window by clicking on the 
radio button next to each applicable field. 
The type of information you select—and which person you select it from—affects the 
information that is retained for the Person Forward. See “The Person Forward 
Selection Window” on page 29 for details. 

13 When you have made all of your selections from the Person Forward Selection 
window, click on the OK button.  
The name of the person logged on and the date of the Merge displays in the Staff 
NM Merge and Date Merge fields. 

14 Click on the Save button. 
The change is saved in the system and the Person List displays. 

15 Click on the Close button. 
The Task List displays. 

16 Click on the Close button. 
The Assigned Workload displays. 

 

Step-by-Step: 
Completing a Person Merge from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS Toolbar. 
The Person Search window displays. 

2 Perform a Person Search.  

3 In the Person Search List, click on the person who is to be listed in the Merged 
Persons Closed section of the Person Merge/Split window. 

4 Click on the Options menu and select Case List. 
The Case List displays. 

5 Click on the applicable case to select it. 

6 Click on the Summary button. 
The Case Summary window displays. 

7 Click on the applicable stage. 

8 Click on the Options menu and select Person List. 
The Person List displays for the selected stage. 

9 Click on the Options menu on the Person List and select Person Merge/Split. 
The Person Merge/Split window displays with the selected person’s name pre-filled 
in the Merged Persons Closed section. 

10 Review the Name and Person ID information in the Merged Persons Closed section 
for accuracy. 

11 Enter the Person ID of the Merged Forward Person in the Forward section. 
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12 Click on the Validate button. 
The system checks for an open case and a valid 
Person ID. The Merge button enables. 

 

Things to Consider  
Before Splitting: 

The Merge Forward Person 
cannot be deleted from the 
stages that were open at the 
time the Person Merge took 
place. The Merged Closed 

Person’s pre-merge information 
is not “reattached” by 

completing a Split. Follow-up 
demographics and case/stage 
maintenance are necessary to 

complete the process. 

You need to record that 
person’s demographic 

information again and re-
associate the person with the 
appropriate case(s)/stage(s). 

The Person Data report 
contains the current and 
historical information of a 

person. 

To run the report: 

1 Select the person on the 
Person List. 

2 Click on the Reports menu 
and select the Person Data 
command. 
The following message 
displays: “The report has 
been launched. Check 
Report List window.” 

4 Click on the OK button. 

5 Click on the RPRTS button. 

6 Select the Person Data 
Report and click on the 
Open button. 

This provides a hard copy of all 
information stored in 

CONNECTIONS about a 
specified person, including 

Merge/Split history and 
demographic changes. 

13 Follow Steps 9-18 on “Completing a Person Merge 
within the Assigned Workload” on page 29. 

 

Step-by-Step: 
Completing a Person Split 

1 On the Assigned Workload, select the stage which 
contains the person information that was merged in 
error. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays for the selected stage. 

3 Click on the Maintain Person task. 

4 Click on the List… button. 
The Person List displays for the selected stage. 

5 Click on the name of the person who was merged in 
error.  

6 Click on the Options menu and select Person 
Merge/Split. 
The Person Merge/Split window displays. The 
system pre-fills the person’s name into the Merged 
Persons Closed section. 

7 In the list section at the top of the window, select the 
Merge you want to split. 
The system fills the Merge information into the detail 
section of the window. 

8 Click on the Split button. 
The following message displays: “Split ID# from 
ID#?” 
The first ID number listed is for the Closed Person. 
The second ID number is for the Forward Person. 

9 Click on the Yes button. 

10 Click on the Save button. 
The change is saved in CONNECTIONS. The 
Person List displays.  
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Module 2: 
Case Maintenance 

There are times when a worker may need to change a case name. An example of this would be 
if a Principal of a case gets married or divorces and her last name changes as a result. Cases 
may also need to be merged if there are duplicate cases open in CONNECTIONS. Conversely, 
cases may need to be split if two different cases were merged into one. Sometimes cases are 
left open in the system when they should be closed and closed when they should be open. 
CONNECTIONS provides several Case Maintenance functions for these tasks. 

By the end of this module, you will be able to: 

• change a case name; 

• merge cases; 

• split cases; and 

• change the case status. 
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Changing the Case Name 
New cases are named after the first Principal (usually the 
mother) who is added to the initial report (Intake). Each stage 
(e.g., Intake or Investigative) of a case also has a Stage Name. 
The Stage Name may or may not be the same as the Case 
Name, depending on information known at Intake, changes in 
family composition, or other variables. 

The individual authorized to change the case name is subject 
to local district policy and procedure. This task may not fall 
under the scope of the individual caseworker’s responsibilities. 
In order to perform the Change Case Name function, the 
worker’s BFP must include the appropriate Business Functions.  

You may occasionally need to change the Case Name. If you 
update a person’s name that is also used as the Case Name, 
or if the case has the wrong name, you need to change the 
Case Name. In the first instance, you must always change the 
person’s name before you change the Case Name. This name 
change affects the name of all the stages in that case. 

 

Step-by-Step: 
Changing the Case Name 

1 Click on the WORK button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 

2 Click on the stage which requires a Case Name 
change. 

3 Click on the Options menu and select Case (Stage) 
Name/CD. 
The Case (Stage) Name/CD window displays. 

4 Click on the drop-down arrow for the New Name 
field. 
A list displays of the Principals in the case. 

5 Click on the name you want to use to change the 
Case Name. 
You cannot record a name here; you must select a 
name from the drop-down list. 

6 Click on the Save button. 
The Assigned Workload displays. The selected 
stage now reflects the new 
Case Name. 

7 Click on the Close button. 

 
NYC workers also use this 
window to correct or update 

Community District information 
in the CD field for the 

assignment of the stage. NYC 
stages cannot be progressed 

without the CD field completed. 

 

ACS policies regarding 
naming cases have changed. 
The following rules now 
apply: 

• Cases initiated by a call to 
the SCR must be named for 
the alleged subject of the 
report. 
 If there is more than one 
subject, the case must be 
named for the subject 
listed first on the intake 
report. 

 If a subsequent report is 
received while the original 
case is open, the case 
remains in the name of 
the original subject. 

 If a subsequent report is 
received and the original 
case is closed, the case 
is renamed based on the 
subject listed first on the 
new report. 

• All non-CPS cases must be 
named for the individual 
requesting services. 

• All cases where a child is 
freed or the child’s 
parentage is unknown must 
be named for the child. 



 

Case Merge/Split Functions 
The Case Merge/Split function allows you to merge two separate cases into one case, sharing 
the same CONNECTIONS Case ID, or to split a case that was previously merged. Both open 
and closed cases can be merged. 

The individual authorized to perform the Case Merge/Split function is subject to local district 
policy and procedure. This task may not fall under the scope of the individual caseworker’s 
responsibilities. In order to perform the Case Merge/Split function, the worker’s BFP must 
include the appropriate Business Functions. 

Case Merges are most often completed by an SCR Intake worker when the worker identifies 
that the family reported in the current intake is already involved in an open case in 
CONNECTIONS. The new intake is considered a subsequent Intake/report in the open case. 
When this information is verified, the SCR Intake worker merges forward the subsequent intake 
into the existing open CONNECTIONS case. 

There are other times when the SCR Intake worker does not merge the new Intake into an 
existing case, but you may find while providing services to a family that completing a Case 
Merge allows you to manage the case better. At that time, request direction from your 
supervisor to determine whether the proposed Merge fits within the standards of your local 
district’s policies and procedures for case merges. 

Case Merges and Splits are pending until after the batch update is run overnight. At that time, a 
series of edits and checks are performed by CONNECTIONS to verify that the two cases can be 
merged or split. You can identify whether a Merge is still pending from the Merge/Split window 
or the Case List. “PF” indicates the Pending-From case and “PT” indicates the Pending-To case 
for Merges that are pending batch update.  

If the pending Split fails the edit checks in the batch run, the worker needs to process the Split 
again. DUP or ADD Intake stages that are split are re-opened and placed on the Assigned 
Workload of the Primary worker.  

After the batch update, the case that is Merged-From displays “MF” in the Merge column on the 
Case List; the case that is Merged-To displays “MT” in the same column. Both Case IDs, when 
searched, point to the Merged-To Case. 

When a worker splits an Intake stage from a case and progresses it, prior to the nightly split 
batch update, CONNECTIONS determines if the stage is linked to any other stage. When the 
split batch update is run, the system moves all stages that are identified as belonging together. 
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Step-by-Step: 
Completing a Case Merge from the Assigned Workload 

1 Click on the WORK button. 
The Assigned Workload displays. 

 

When merging cases, warnings 
and/or error messages may 

display. Warnings do not 
prevent you from completing a 
Merge, but error messages do. 
Carefully review and consider 

both error messages and 
warnings before proceeding. 

 

There must be at least one 
Person ID in common with both 
cases/stages in order to perform 
the Case Merge/Split function. 

 

If you determine that the case 
selected to be Merged From 

should, in fact, be Merged To, 
you must exit the Case 

Merge/Split window and begin 
the process again by selecting 

the other case. The switch 
function is not available in the 

Case Merge/Split window. 

2 Select the case to be Merged To. 

3 Click on the Options menu and select Case 
Summary. 
The Case Summary window displays. 

4 Click on the Options menu on the Case Summary 
window and select Case Merge/Split.  
The Case Merge/Split window displays.  

5 Enter the Case ID number for the case you wish to 
merge in the Case Merged From section. 
The Case Merged To field is pre-filled. 

6 Click on the Validate button. 
The system checks to see if the Merge is possible 
and may display error messages or warnings (see 
the tip box above). When the check is complete, the 
Merge button enables. 

7 Click on the Merge button. 
In the list at the top of the window, the Merge 
displays with a red checkmark in the Pending 
column. 
 

NOTE: If you realize that you have made a mistake 
in selecting your cases, click on the Cancel button 
and then click on the Yes button at the prompt 
asking if you wish to exit without saving. The Case 
Merge/Split window closes and the Merge is 
canceled. 

8 Click on the Save button. 
The Case Summary window displays. 

9 Click on the Close button. 
The Assigned Workload displays. 
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Step-by-Step: 
Completing a Case Split 

1 Click on the WORK button. 
The Assigned Workload displays. 

2 Select the case to be split. 

3 Click on the Options menu and select Case 
Summary. 
The Case Summary window displays. 

4 Click on the Options menu on the Case 
Summary window and select Case Merge/Split. 
The Case Merge/Split window displays. 

5 From the list section at the top of the window, 
click on the Case Name that was merged in 
error. 
The Merge information for the selected case displays in the detail section at the 
bottom of the window. 

 

When splitting cases, warnings 
and/or error messages may 

display. Warnings do not 
prevent you from completing a 
Spliy, but error messages do. 
Carefully review and consider 

both error messages and 
warnings before proceeding. 

6 Click on the Split button. 
A red checkmark displays in the Pending column in the list section. 
 
NOTE: If you realize that you have made a mistake in selecting the case to be 
split, click on the Cancel button. The following message displays: 
“Do you want to cancel? Unsaved data and/or narrative(s) will be lost.” 
If you click on the Yes button in response to the message, the Case Merge/Split 
window closes and the Split is cancelled. 

7 Click on the Save button. 
The Case Summary window displays. 

8 Click on the Close button. 
The Assigned Workload displays. 
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Changing the Case Status 
If a case that was kept open at the conclusion of the Investigation stage needs to be closed (or 
a case that was closed needs to be reopened), the Case Status Maintenance function is used to 
update the status of the case. 

The Case Status Maintenance (CSM) Report was created to assist districts in identifying cases 
that have an “Open” status in the system, but may need to be closed. The CSM Report 
identifies cases in the district that have “Open” case statuses but no open CPS stages. The 
report is run monthly and displays on the Report List for designated CONNECTIONS users. The 
Report List is opened from the RPRTS button on the CONNECTIONS Toolbar. The cases 
identified on the report can be closed using the online Case Status Maintenance function. 

To change Case Status, the following criteria must be met: 

• All stages of the case must be closed (a case may be still be shown as open if the 
worker has closed the stage(s) with an Open Closure Reason). 

• Your district must match the district of the case in question.  

• You must follow CPS case closing guidelines. 

In addition, you must be: 

• the last historical primary worker in the case; 

• the last historical case manager; 

• in the unit hierarchy of the historical primary worker in the case and have a role at or 
above the role of the Unit Approver; or 

• assigned a “View All in District” Business Function Profile (BFP). 

You can change the status of a case from the Case Summary window. 

 

Step-by-Step: 
Closing an Open Case 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the Case ID number or the Case Name in the appropriate field. 

3 Click on the Search button. 
The Case List displays. 

4 Click to select a case. 

5 Click on the Summary button. 
The Case Summary window displays. 
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6 From the Case Summary window of an open case, click on the Options menu and 
select Change Case Status. 
The following message displays:  
“The case status will be changed to CLOSED. Continue?” 

7 Click on the Yes button. 
The Close Case window displays. 

8 If a closure date other than the default (current) date is required, enter the closure 
date in the Case Closure Date field. 
The Case Closure Date field entry must be a valid date (e.g., not February 30), 
cannot be a future date, and cannot pre-date the latest stage closure date. 

9 Click on the Save button. 
The Case Summary window displays. The status of the selected case is now 
“Closed.” A “Case Closed” event also displays on the Event List. 

10 Click on the Close button. 
The Case List displays. 

11 Click on the Close button. 
The Case Search Criteria window displays. 

 

Step-by-Step: 
Opening a Closed Case 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the Case ID number or the Case Name in the appropriate field. 

3 Click on the Search button. 
The Case List displays. 

4 Click to select a case. 

5 Click on the Summary button. 

6 From the Case Summary window of a closed case, click on the Options menu and 
select Change Case Status. 
If the case does not have stages closed with an 
“Open for Services” Closure Reason, the following 
message displays: “No stage in case had been 
closed with an open for services reason. Continue?” 
This is only a warning message; it will not prevent 
you from continuing. You may want to verify that you 
selected the correct case from the list. 

7 Click on the Yes button. 
The following message displays: 
“The case status will be changed to OPEN. Continue?”  

 

Changing the Case Status to 
“OPEN” does not return the 

case to the Assigned Workload. 
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8 Click on the Yes button. 
The case status changes to OPEN and the Case Summary window displays. A 
“Case Re-Opened” event also displays on the Event List.  

9 Click on the Save button. 

10 Click on the Close button. 
The Case List displays. 

11 Click on the Close button. 
The Case Search Criteria window displays. 
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Module 3: 
Local Data Maintenance 

The LDM function in CONNECTIONS is used to maintain closed investigations. This is a 
corrective process only. It is to be used exclusively to correct errors or oversights in the original 
investigation. The original investigation narrative must support these corrections. Maintain 
Closed Investigation should not be used to record new information about an investigation that is 
learned after the investigation is closed. (In that circumstance, a new report should be called in 
to the SCR.)  

By the end of this module, you will be able to: 

• access the Local Data Maintenance (LDM) window; 

• change person demographics; 

• add or relate persons to a stage; 

• modify allegations; and 

• edit the investigation conclusions. 
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Local Data Maintenance (LDM) Security 
There are situations in which case information for a closed CPS Investigation needs to be 
corrected. For example, a person’s demographic information might have been recorded 
incorrectly or perhaps allegations were omitted in error. The Local Data Maintenance (LDM) 
window is a single, multi-tabbed window that allows the viewing and correction of information in 
closed CPS Investigation stages. The LDM window can be used to add and relate persons to 
closed investigations and to correct person demographic information, allegations, and 
investigation conclusion details. 

The LDM window contains the following tabs: 

• Person Demographics 

• Add/Relate Person 

• Allegations 

• Investigation Conclusions 

These tabs enable depending on how the LDM window is accessed and the Business Function 
of the worker accessing the window. Two Business Functions are associated with Local Data 
Maintenance: 

• MAINT CLSD PERS 
Maintain Closed Person Demographics can be used to correct demographic 
information due to an error in data entry in the original investigation or due to the 
availability of additional information. 

• MAINT CLSD INV (available only for designated CPS Supervisors or above) 
Maintain Closed Investigation is a corrective process only. It is to be used exclusively 
to correct errors or oversights in the original investigation. The original investigation 
narrative must support these corrections. Maintain Closed Investigation should not be 
used to record new information about an investigation that is learned after the 
investigation is closed. In that circumstance, a new report should be called in to the 
SCR. 

To view your own Business Function Profile, see “Viewing Your Business Function Profile” on 
page 10 of this guide. 

The actions permitted by each of these Business Functions and methods of accessing the LDM 
window are discussed in this module. 

The table on the next page contains information about further requirements associated with 
Local Data Maintenance.  
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LDM Business Functions and Access Requirements 

Case Summary 
Window 

Options Menu 
Command 

Maintain Closed Person 
Demographics Maintain Closed Investigation 

Business 
Function Needed  MAINT CLSD PERS MAINT CLSD INV 

• Investigation Stage (CPS or 
IAB) is closed  

 and 

• Worker must be from same 
district/agency as primary 
worker when stage was 
closed 

 and either: 
Additional 

Access 
Requirements 

Closed stage is 
not associated 
with any open 
ARI stage, or 

Worker is 
Primary worker 
of associated 

open ARI stage 

• Investigation Stage 
(CPS or IAB) is closed  

  and 

• Worker is at Supervisor 
level or above 

  and 

• Worker must be from 
same district as primary 
worker when stage was 
closed 

  and 

• Closed stage is not 
associated with any 
open ARI stage 

LDM Tabs 
Enabled Person Demographics All LDM tabs 

 

Selecting either Maintain Closed Investigation or Maintain Closed Person Demographics 
opens the LDM window in modify mode. 
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Accessing the LDM Window 
The LDM window can be accessed through the Case Summary window and through the Event 
List. There are three main features of the LDM window: the Header and Footer (which are 
always present), and the tabs, which comprise the body of the window and are accessible in 
any order. 

Accessing LDM from the Case Summary Window  
Since the case in question is closed, it does not appear on the Assigned Workload. Therefore, it 
is necessary to perform a case search. Select the case from the resulting Case List and click on 
the Summary button to open the Case Summary window. 

 

Step-by-Step: 
Accessing LDM from the Case Summary Window 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the Case ID or Case Name in the appropriate 
field. 

 

Each of these menu commands 
enables only if the worker meets 
certain access requirements. In 
addition, particular tabs of the 
LDM window enable or disable 
depending on how the window 

is accessed. 

3 Click on the Search button. 
The Case List displays.  

4 Click on the case to be viewed/updated. 

5 Click on the Summary button. 
The Case Summary window displays. 

6 Click to select the INV stage to be viewed or 
updated. 

7 Click on the Options menu and select Maintain 
Closed Investigation. 
The Local Data Maintenance window displays. 

8 To close the LDM window, click on the Close button. 
The Case Summary window displays. 

9 Click on the Close button. 
The Case List displays. 

10 Click on the Close button. 
The Case Search Criteria window displays. 

11 Click on the Close button. 
The CONNECTIONS Toolbar displays. 
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Accessing LDM from the Event List  
Accessing the LDM window through the Maintain Closed Investigation command in the 
Options menu on the Case Summary window can create one of two events: 

• Maintain Closed CPS Investigation – created when a worker updates a closed CPS 
Investigation stage in the LDM window and any information is modified and saved. 

• Maintain Closed IAB Investigation – created when a worker updates a closed IAB 
Investigation stage in the LDM window and any information is modified and saved. 

Once an event is created, the LDM window can be accessed through that event. 

Access to LDM events is similar to that for other INV stage events such as Investigation 
Conclusion. That is, all LDM events are displayed or filtered in the Event List window based on 
a worker’s security.  The worker must have the appropriate CPS Business Functions and have 
jurisdictional, role, or unit hierarchy access to the case. Since this is view-only access, the 
MAINT CLSD INV Business Function is not required. As a rule of thumb: If your credentials 
allow you to see the Investigation Conclusion event for a stage, you will be able to see and 
access the LDM event. 

 

Step-by-Step: 
Accessing LDM from the Event List 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the Case ID or Case Name in the appropriate fields and click on the Search 
button. 
The Case List displays.  

3 Select the INV stage to be viewed/updated. 

4 Click on the Options menu and select the Event List command. 
The Event List displays. 

5 Select the event that has Local Data Maintenance in the Type column and click on 
the Detail button. 
The Local Data Maintenance window displays in 
view-only mode, none of the window’s elements are 
modifiable. 

 
No events are generated if the 

LDM window is accessed 
through the Maintain Closed 

Person Demographics 
command. 

6 Click on the Close button. 
The Event List displays. 

7 Click on the Close button. 
The Case List displays. 

8 Click on the Close button. 
The Case Search Criteria window displays. 

9 Click on the Close button. 
The CONNECTIONS Toolbar displays. 
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The Layout of the LDM Window 

The Header 
The Header is always present when the LDM window is open. It includes the following 
information: 

• Case Name 

• Case ID 

• Stage ID 

• Report Date  
(the intake report date) 

• Case Status 

• Event Status 

• Final Risk Rating 

• Elevated Risk 
Exists label (if any 
Elevated Risk 
Elements were 
selected on the 
RAP)  

The Event Status that displays depends on how and under what circumstances the LDM 
window was opened. This status is modified when changes are saved on the LDM window. 

• If the LDM window is opened via the Event List, the Event Status field displays the 
status of the event that was selected on the Event List (either PROC or COMP). 

• When the LDM window is opened via the Maintain Closed Investigation command in 
the Options menu on the Case Summary window, the status displays “In Process” if 
there is an in-process event associated with the closed Investigation stage. Otherwise, it 
reads “New.” In this case, if any changes are saved on the LDM window, the status field 
changes from “New” to “In Process.” 

• If the LDM window is opened via the Maintain Closed Person Demographics command 
in the Options menu on the Case Summary window, the Event Status field on the LDM 
window is blank. 

• LDM events have a status of PROC (In Process) when created. 

• Only one PROC LDM event can exist for a closed INV stage at a time.  

• Modifying a stage that already has a PROC LDM event does not generate another event 
or change the status of the existing event. 

• LDM events are marked COMP as part of the process of closing the LDM window. 
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The Footer 
The footer is always present when the LDM window is open. Only one button appears in the 
footer: Close. Clicking on this button closes the LDM window and returns you to the window 
from which the LDM window was accessed (either the Event List or the Case Summary 
window). The Close process also gives you the opportunity to save any unsaved changes to the 
LDM window and to mark the PROC event associated with the LDM as COMP. 

The Tabs 
The information contained in the body of the LDM window is organized into sections, which are 
represented by file tabs: 

• Person Demographics • Allegations 

• Add/Relate Person • Investigation Conclusions 

 
If the LDM window is accessed through the Maintain Closed Person Demographics 
command, only the Person Demographics tab is available for modification. If the LDM window 
is accessed through the Maintain Closed Investigation command, all tabs are available for 
modification. 

 

Step-by-Step: 
Viewing the Tabs on the LDM Window 

1 Open the LDM window for the selected stage. 
See “Accessing the LDM Window” on page 44. 

2 Click on a tab to view its contents. 
Tabs may be accessed in any order. 

3 Click on the Close button to close the LDM window. 

Information recorded in the LDM window is stored in the CONNECTIONS database. When you 
re-open the LDM window, it is “refreshed” with the most current information. This information 
can be reviewed and, if necessary, updated further. 
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Person Demographics Tab 
The Person Demographics tab allows workers to view and correct information about persons 
associated with a closed Investigation stage. This tab is the active tab whenever the LDM 
window is first opened. It contains an upper and lower grid and Save, Cancel and 
Address/Phone buttons. 

The Upper Grid 
The upper grid contains the following information about all persons associated with a closed 
INV stage:  

• Primary Name • Age • Language 

• Person ID • Religion • Marital Status 

• DOB • T (DOB Type) • Sex 

• Race • Role • Relationship/Interest 

• Phone • Extension • Phone Type 

• DOD 
(Date of Death) 

• Approx. DOD Flag • Ethnicity 

 
Updating a person’s date of birth in LDM changes the person’s 
date of birth in all other stages containing that person. Since a 
person in open stages cannot be modified, the affected stages 
are all closed stages.  

The Date of Death and 
Approximate Date of Death 

columns can only be modified if 
a Date of Death already 

appears in the grid for that 
person. 

The Age field cannot be modified if there is an exact date of 
birth listed in the DOB field. If corrected exact date of birth 
information becomes available, correct the DOB field; the Age 
field updates automatically. If the DOB is marked Approximate 
(A) or Estimated (E), the Age field can be modified. When Age 
is modified, the DOB is recalculated and updated. If new exact 
date of birth information is recorded, be sure to change the 
date of birth type in the T column. 

Before changing a person’s name on the Person Demographics tab, a Person Search needs 
to be performed to see if the new name is known to the system. If the name is known, use the 
Add/Relate Person function (see the Step-by-Step on page 60) rather than change the name 
on the Person Demographics tab. After the individual is related to the closed stage, both 
individuals (the one who was originally on the Person List and the one you just related) will 
display. You will need to perform a Person Merge (see page 28 for more information on Person 
Merging).  

The Race and Ethnicity of the person selected in the Upper Grid can be modified using the 
drop-down arrow and list boxes in the bottom right-hand corner of the tab.  
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Field Enabling Modification 
Ethnicity 
(drop-down 
field) 

Enables when a person is 
selected in the upper grid. 

Updates the Ethnicity column in the 
upper grid. This field displays “NR” 
when the Ethnicity column in the 
upper grid reads “Not Reported.” 

Ethnicity 
(list box) 

Enables when a person is 
selected in the upper grid AND 
“Hispanic or Latino Origin” 
displays in the Ethnicity drop-
down. 

Click on an origin to select it from the 
list. Multiple origins may be selected. 

Race 
(list box) 

Enables when a person is 
selected in the upper grid. 

Updates the Race column in the 
upper grid. Click on a race to select it 
from the list. Multiple races may be 
selected. If more than one Race is 
selected in this field, the upper grid 
displays “Multiple.” 

 

Clicking in a row of the upper grid selects that person for modification. An arrow to the left of a 
row indicates that the information in the lower grid applies to that person.  

All columns in the upper grid are modifiable by clicking directly in the grid cell and typing, with 
the following exceptions: 

 

Column Modified by… 
Person ID  Cannot be modified 

This number is system generated 

Race Race selection box elsewhere on Person Demographics tab 

Ethnicity Ethnicity drop-down and selection box elsewhere on Person 
Demographics tab 

Phone, 
Extn, Type 

Maintain Primary Address/Phone window. Accessed via 
Address/Phone button elsewhere on Person Demographics tab 

Role Automatic (re)calculation when changes to Allegations tab are saved 

 

CONNECTIONS Data Maintenance Step-by-Step Guide Page 49 
Training for CPS Caseworkers  v1.1 (rev 06/13/2006) 



The Lower Grid 
The lower grid displays the following information for each identifier: 

• ID 

• Invalid Flag 

• ID Type 

• ID Number 

• Start Date 

• End Date 

• Comment 

When a person is selected in the upper grid, the lower grid displays all person identifiers (SSN, 
CIN, etc.) for that person. Each identifier appears in its own row of the lower grid. An arrow to 
the left of the row indicates that identifier is currently selected for editing. New identifiers can be 
added by typing into the bottom-most row of the lower grid, which is marked with an asterisk. 
Adding a new row with the same Type as an existing row (that does not have an End Date) sets 
the End Date of that existing row to the current date.  

The information in the lower grid is modifiable as follows: 

Column Modified by… 

ID Invalid Flag 
Can only be marked (using the drop-down arrow that appears when 
you click in the cell); cannot be removed. Marking the flag as Invalid 
will set the end date of that row to the current date. 

ID Type 
Can be selected for new rows using the drop-down arrow that 
appears when you click in the cell. This field cannot be modified for 
existing rows. 

ID Number Can be modified by clicking and typing directly in the grid. Cannot 
be modified in a row for which an End Date exists. 

Start Date Automatically set to the current date when a new ID type is added. 

End Date 
Automatically set to the current date when the ID Invalid Flag is 
selected (marked) or when a new row with the same ID Type is 
added. 

Comments Can be modified by clicking and typing directly in the grid. Cannot 
be modified in a row for which an End Date exists. 
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Buttons on the Person Demographics Tab 

Address/Phone 
The Address/Phone button accesses the Maintain Primary Address and Phone window for the 
closed INV stage, allowing the worker to modify Primary Address and/or Primary Phone 
information for all persons associated with the closed INV stage. 

Clicking on this button with unsaved changes pending in the LDM window displays the following 
message: “Please save or cancel changes before maintaining address information.” 

• Clicking OK returns you to the Person Demographics tab. 

• Clicking the Save or Cancel button on the Person Demographics tab allows you to 
open the Maintain Primary Address and Phone window with changes having been 
saved or discarded depending on which was selected. 

If any changes are made and saved on the Maintain Primary Address and Phone window and 
an in-process LDM event does not already exist, an LDM event is created. (This is only true if 
the LDM window was entered through the Maintain Closed Investigation command. No events 
are generated if the LDM window is entered through the Maintain Closed Person Demographics 
command.) 

Trying to open the Maintain Primary Address and Phone window when every person in the case 
is also in an open non-ARI stage results in the following message displaying: “Cannot maintain 
address/phone information: Everyone in this closed case is also in another open non-ARI 
stage.” The Maintain Primary Address and Phone window does 
not open. (See “Maintaining Primary Address and Phone” on 
page 16.) 

 
Save 
Clicking on this button saves changes made on the tab. It is 
disabled until changes are made on the Person 
Demographics tab. The Save button disables after a save until 
the next time changes are made to the tab.  

Close 
Clicking on this button closes the LDM window and returns you 
to the window from which the LDM window was accessed, 
either the Event List or the Case Summary window. The Close 
process also gives you the opportunity to save any unsaved changes to the LDM window and to 
mark the PROC event associated with the LDM as COMP. 

If the child’s age has been 
modified to be more than 18 

years old for CPS Familial/FC-
DC cases or more than 21 
years old for IAB cases, the 
following message displays 
when you click on the Save 

button:  
“Age over <18 or 21> years as 
of Intake. Continue with Save?” 

Cancel 
Clicking on the Cancel button cancels all changes made to the tab since the last save. It is 
disabled until changes are made on the Person Demographics tab. Clicking on the Cancel 
button displays the following message: “Your changes will be lost. Continue?” Clicking Yes 
discards any unsaved changes. Clicking No leaves the changes as they were entered. 
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Step-by-Step: 
Changing Person Demographics in the Upper Grid 

1 Open the LDM window for the selected stage. 
See Accessing the LDM Window on page 44. 

2 Select the person from the Person List by clicking 
in the column left of the Last Name. 
A black arrow indicates the person that has been 
selected. 

3 Click in the DOB field and update the information 
located there.  
If the child’s age has been modified to be more than 
18 years old for CPS Familial/FC-DC cases or more 
than 21 years old for IAB cases, the following 
message displays when the Save button is clicked: 
“Age over <18 or 21> years as of Intake. Continue 
with Save?” 

4 Click on the Save button. 

5 To change ethnicity, click on the drop-down arrow 
for the Ethnicity field and select from the resulting 
list. 
Select either “Hispanic or Latino Origin” or “Non-
Hispanic or Latino Origin,” as appropriate. 

6 To specify categories within Hispanic or Latino 
origin, click on an origin’s checkbox from the list below the Ethnicity field. 
In order to select an origin in this field, “Hispanic or Latino Origin” must display in the 
Ethnicity field. An “X” displays in a specific origin’s checkbox when it has been 
selected. To clear a selection, click on the box again 
to remove the “X.” Multiple origins may be selected 
from the list box. 

 

If an Investigation stage was 
closed with the Fatality – No 
Surviving Children closure 

reason, the Date of Birth (DOB) 
of any person may not be 

changed to younger than 18 
years old before the date of 

Intake. If the worker attempts 
to do this, the following 

message displays: 

“Cannot update or add person 
less than 18 years of age. The 

stage was closed with Fatality – 
No Surviving Children.” 

The only exception to this 
occurs if the person has a Date 
of Death (DOD) or is a subject 

in an allegation. 

 

Correcting demographic 
information for a person who is 
associated with an open stage 
can only be done in the Person 
Detail window, not through the 

LDM window. Conduct a person 
search to determine if the 

person in question is associated 
with any open stages. 

If the person search indicates 
that the person is not 

associated with any open 
stages, you can navigate to the 

LDM to correct demographic 
information. 

7 Click on the Save button to save the changes to the 
Ethnicity field. 

8 In the Race field, click on a race’s checkbox from 
the list to select it. 
An “X” displays in the checkbox when it has been 
selected. To clear a selection, click on the box again 
to remove the “X.” Multiple races may be selected 
from the list box. 

9 Click on the Save button to save the changes to the 
Race field. 

10 Scroll right and click in the Language field to select 
a different language. 
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11 Click on the Save button. 

12 If you are finished correcting information on the 
Person Demographics tab, either click on another 
tab (to correct information on a different tab) or 
close the LDM session   

You must save (click on the 
Save button) after each change 

you make to the Person 
Demographics tab in order for 
that change to be stored in the 

CONNECTIONS database. 
Therefore, if more than one 

change has been made, only 
the last one, if unsaved, is 

discarded when No is clicked. 

13 Click on the Close button. 
The following message displays: “Is LDM 
Complete?” 

14 Click on the Yes button. 
The Case Summary window displays. 

15 Click on the Close button. 
The Case List displays. 

 

Step-by-Step: 
Changing Person Demographics in the Lower Grid 

1 Open the LDM window for the selected stage. 
See Accessing the LDM Window on page 44. 

2 Select the person from the Person List by clicking in the column to the left of the 
Last Name. 
A black arrow indicates the person that has been selected. 

3 Click on the drop-down arrow in the INV column and select No. 
This indicates that the person identifier is not invalid (clicking Yes indicates that it is 
invalid). 

4 Click on the drop-down arrow in the Type column. 
Click on the type of identifier being entered. 

5 Click in the Number column and enter the identifier number. 

6 Click on the Save button. 

7 Click on the Close button. 
The Case Summary window displays. 

8 Click on the Close button. 
The Case List displays. 

9 Click on the Close button. 
The Case Search Criteria displays. 

10 Click on the Close button. 
The CONNECTIONS Toolbar displays. 
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The Add/Relate Person Tab 
The Add/Relate Person tab enables workers to: 

• add new persons to CONNECTIONS and to closed Investigation stages; 

• search for persons already in the CONNECTIONS database; and 

• relate persons already in the CONNECTIONS database. 

Fields and Buttons on the Add/Relate Person Tab 
Before a person can be added or related to a closed Investigation stage, a search of the 
CONNECTIONS database must be performed on the person’s name. For this reason, the 
Add/Relate Person tab is formatted much like the Person Search window. 

The Search Type field displays in the upper left corner of the tab. Click on the drop-down arrow 
for this field and select from the resulting list. The default Search Type is “Phonetic Name” when 
the tab is first opened. 

The Add/Relate Person tab includes fields for the following search criteria: 

• First Name 

• Middle Name 

• Last Name 

• DOB 
(Date of Birth) 

• Age 

• Race 

• Sex 

• Phone 

• Address Type 

• Street 

• PO Box/Apt 

• City 

• State 

• County 

• ZIP Code 

• CD (NYC 
addresses only) 

• SSN 

• CIN 

• Person ID 

The Validate button performs CODE 1 validation for addresses (it is disabled until address 
information is entered). 

The Search button searches the database for the person information entered (it is disabled until 
person information is entered). 

The Relate button adds a person who is already in the database to a closed Investigation Stage 
(it is disabled until a search is performed and a row is selected from the Person Search List). 

The New button opens the Add Person window (it is disabled until a phonetic name search is 
performed). 

The Clear button clears all entries made to search criteria fields (it is disabled until data fields 
are filled in). 

The Close button closes the LDM window. 
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Searching Before Adding or Relating 
The search functionality in LDM does not allow for viewing of 
individual Person Search results beyond what appears in the 
Results List tab. You cannot select a result and navigate to the 
Case List, Case Composition window etc., within LDM. 
Therefore, prior to entering LDM, you should conduct a more 
comprehensive Person Search from the CONNECTIONS 
Toolbar. There, you can confirm either the Person ID for a 
known individual, or verify that there is not a match. Once the 
Person Search results are verified through the Toolbar search, 
the known person can be related or the new person added 
through LDM. 

The Search Type field displays in the upper left corner of the 
tab. Clicking the drop-down arrow for this field opens a menu of search type choices. The 
Search Type defaults to “Phonetic Name” search when the Add/Relate Person tab is first 
opened.  

 

The Relate button does not 
enable until a search has been 

performed and a person is 
selected from the results list. If 
any information on the tab is 
changed after the search, the 

Relate button is again disabled 
until another search is 

performed. 

As on the Person Search window, certain fields are required depending on the type of search 
chosen. These required fields are highlighted in yellow and must be filled in before the Search 
button enables. The type of search chosen also determines which additional criteria can be 
entered. 

 

When searching on a person 
with multiple last names, adding 
a hyphen between the two last 
names creates a result list that 

includes all possible 
combinations of the two names. 

When the search type is Exact: 

• Address fields enable only when all non-address fields 
are blank. 

• Each identifier field enables only if all other fields are 
blank. 

• All other text fields enable only when all address and 
identifier fields are blank. 

• The address criteria section includes a Validate button for validation of addresses 
entered for the search. 

Search results display in the Person Search List grid in the lower portion of the tab. In addition 
to the Match Name, results include: Date of Birth, T (type), Sex, Person ID, County, Street 
Address, City, Race, Ethnicity, SSN, Primary Name, Match (Match Type), and Score. 

When the search is completed, the title of the Person Search List box reflects the results with 
one of the following titles: “Phonetic Name Search Results Returned,” “Phonetic Address 
Search Results Returned,” “Exact Results Returned,” or “No Results Returned.” 

If one of the persons returned in the search result matches the person entered for the search, 
that person can be selected by clicking on his/her row of the Person Search List.  

Clicking on the Relate button relates the selected person to the closed Investigation stage.  

• A validation is performed comparing the information of the person selected in the Person 
Search List with the search criteria entered. The validation includes DOB, Sex, County, 
Relation/Interest and Abused Child vs. Alleged Subject Role. If any of these comparisons 
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produce a mismatch, a message to that effect displays, asking if the relate should be 
performed anyway. 

• The new information is saved to the CONNECTIONS database and the Person 
Demographics tab opens. The person you just added is selected and the updated 
information for that person is displayed. 

• The following message displays: “Primary Address from related person used.” 

 

Step-by-Step: 
Searching and Relating a Person in LDM 

1 Conduct a person search from the PERS button on the CONNECTIONS Toolbar. 
This is to obtain the Person ID and verify the information on the person that is to be 
related (if no match is found, the person needs to be added). 

2 Open the LDM window for the selected stage. 
See “Accessing the LDM Window” on page 44. 

3 Click on the Add/Relate Person tab. 

4 In the Search Type field select Phonetic Name. 
Phonetic Name is the default search type. 

 

The name fields of the Add 
Person window are not editable. 

If the person’s name is not 
correct, the worker must click 

Cancel to return to the 
Add/Relate Person tab, update 

the person’s name in the 
Add/Relate Person tab, run 

another Phonetic Name search 
and click the New button again. 

5 Enter the first and last name of the person.  

6 Click on the Search button. 
The name results returned appear in the lower grid. 

7 Scroll down to view all of the results and select the 
correct person to be added/related. 

8 Click on the Relate button. 
The selected person is related to the closed 
Investigation stage and the Person Demographics 
tab opens. 

9 Verify all information in the Person Demographics tab. If changes are made, click 
on the Save button. 

Adding a Person to a Case 
If no records are located for a Phonetic Name Search or if none of the search results match the 
person entered in the search, clicking on the New button on the Add/Relate Person tab 
displays the Add Person window, which allows a new person to be added to the 
CONNECTIONS database and to the closed Investigation stage. 

The Add Person window is pre-filled with the data entered into the search criteria fields of the 
Add/Relate Person tab. All fields except the First, Middle, Last Name, and Role fields are 
editable. 

The layout of the Add Person window is similar to the Person Detail window that is accessed for 
open Investigation stages via the Maintain Person task on the Task List. 
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Values for the Rel/Int, Ethnicity, Race, and either Date of 
Birth or Age fields must be entered before the new person can 
be added to the CONNECTIONS database.  

• Role is defaulted to “No Role” and is not editable. 

• The Rel/Int drop-down arrow enables once a Person 
Type is selected. 

• The approximate DOB checkbox is enabled once a DOB 
is entered. 

When the Date of Birth or Date of Death is recorded, neither 
should be later than the current date. When Date of Birth is 
recorded, the system automatically fills in the Age. When Age is 
recorded, DOB is calculated and populated and the Approximate DOB checkbox is checked. If a 
Date of Death is recorded, a Reason for Death must also be recorded. If an Address is 
recorded, Address Type must also be recorded. 

The Add Person window includes a Validate button for validation of addresses. The Address 
must be validated to enable the Save button on the Add Person window. 

If a Phone Number is recorded, Phone Number Type must also be recorded. 

 

If the child’s age is entered in 
the Add Person window as 

more than 18 years old for CPS 
Familial/FC-DC cases or more 

than 21 years old for IAB cases, 
the following message displays 
when the Save button is clicked: 
“Age over <18 or 21> years as 
of intake. Continue with Save?” 

 
The Add/Relate Person tab is 
disabled and cannot be viewed 

when the LDM window is 
accessed in view-only mode via 

the Event List. 

After all required fields are filled in, the Save and Cancel 
buttons enable.  

The information is saved to the CONNECTIONS database and 
the Person Demographics tab displays. The person you just 
added is selected on the tab and the data for that individual 
reflects the updated information. If the address fields were left 
blank when you added the person on the Add Person window, 
the following message displays:  
“No primary address added for new person.” Clicking on the 
Cancel button clears the fields on the Add Person window and 
displays the Add/Relate Person tab. 

 

Step-by-Step: 
Adding a Person to a Case  

1 Conduct a person search from the PERS button on the CONNECTIONS Toolbar. 
This is to verify that no match is found in the database for the person that is to be 
added. 

2 Open the LDM window for the selected stage. 
See Accessing the LDM Window on page 44. 

3 Click on the Add/Relate Person tab. 

4 In the Search Type field select Phonetic Name. 
Phonetic Name is the default search type. 

5 Enter the first and last name of the person. 

CONNECTIONS Data Maintenance Step-by-Step Guide Page 61 
Training for CPS Caseworkers  v1.1 (rev 06/13/2006) 



Page 62 CONNECTIONS Data Maintenance Step-by-Step Guide  
v1.1 (rev 06/13/2006) Training for CPS Caseworkers 

6 Click on the Search button. 
No results return or none of the results are the correct person. 

7 Click on the New button. 
The Add Person window displays. 

8 Enter the new person information. 
Required fields are highlighted in yellow. 

9 Click on the Save button. 
The new person is now saved to the database and the closed Investigation stage. 
The Add/Relate Person tab displays. 

10 Click on the Close button. 

Allegations Tab 
The Allegations tab allows workers to: 

• view, correct, or add allegation information; 
• delete allegations other than those generated at Intake; 

and 
• view, correct, add, or delete injury details for specific 

allegations. 

The LDM window is to be used exclusively to correct errors or oversights in the original 
investigation. Examples of appropriate use of LDM include: 

Allegation 
Substantiation 
Corrections 

One or more of the original allegations were substantiated and should 
have been unsubstantiated (or vice versa) and the original narrative 
supports the corrected decision. It is important to remember that if the 
subject has received a letter (either a Notice of Indication from the local 
district or a Notice of Unfounding from the SCR) based on the original 
determination, the district is responsible for sending a corrected letter. 

Allegation 
Association 
Corrections 

The original allegations and substantiations were not correctly 
associated with the appropriate child and/or subject (e.g., “allegations 
should have been substantiated for the mother and unsubstantiated for 
the grandmother, not vice versa”; or “bruises should be substantiated 
for the 8 year old and unsubstantiated for the 5 year old, not vice 
versa”). Remember, the original narrative must support the corrected 
information. Corrected notification letters need to be sent, as 
appropriate. 

Adding 
Individuals 
and/or 
Allegations 

The original report from the SCR listed two children left unsupervised. 
There were actually three children left unsupervised, but the case 
worker forgot to add the third child while the investigation was open. 
Again, the original narrative must support the corrected information. If 
additional subjects or “other persons named” are added to the closed 
investigation, appropriate notification letters need to be sent. 

 

The High Priority (NYC only) 
indicator, Roles, and Overall 

Determinations for the stage are 
re-calculated when changes are 

made in the Allegations tab  
are saved. 



 

CONNECTIONS Data Maintenance Step-by-Step Guide Page 63 
Training for CPS Caseworkers  v1.1 (rev 06/13/2006) 

The upper grid of the Allegations tab lists the following information for all allegations in the 
Investigation stage: MA/AB Child (child’s name and ID), Alleged Subject (subject’s name and 
ID), Allegation, Unsub/Sub (unsubstantiated or substantiated), and Stage (the stage in which 
the allegation was entered). 

MA/AB Child 
(child’s name 
and Person ID) 

When selected, the MA/AB Child column displays a drop-down list 
containing the names and Person ID numbers of every child listed 
in the stage. Select from this list to identify an individual as an 
MA/AB child for a new or corrected allegation. 
 

Alleged 
Subject 
(subject’s name 
and Person ID) 

When selected, the Alleged Subject column displays a drop-down 
list containing the names and Person ID numbers of every person 
listed in the stage who is not identified as an MA/AB child. Select 
from this list to identify an individual as an Alleged Subject for a new 
or corrected allegation. 
 

Allegation When selected, the Allegation column displays a drop-down list 
containing all possible allegations. Select from this list to add a new 
allegation or to correct an existing allegation. 
 

Unsub/Sub When selected, the Unsub/Sub column displays a drop-down list 
with two choices: Substantiated or Unsubstantiated. 

For allegations recorded at Intake, this is the only field that can be 
modified on the Allegations tab for the selected Investigation 
stage. 
 

Stage This field specifies the stage (INT or INV) in which the allegation 
was recorded. This field cannot be modified. 

A new allegation can be entered on the blank line in the upper grid that has an asterisk (*) to its 
left. The Stage column displays “LDM” for new allegations 
created in the LDM window.  

When a particular allegation is selected by clicking on it, an 
arrow appears to the left of the line and the lower grid lists the 
following information for all injuries associated with that 
allegation: Injury Side, Injury Area, Injury Type, Injury Cause, 
and Comments. 

A new injury for the selected allegation can be entered on the 
blank line in the lower grid that has an asterisk (*) to its left. 

If an allegation requiring Injury Detail information is added in 
LDM, access to other tabs of LDM or other CONNECTIONS 
windows are prevented until Injury Details are recorded in the lower grid of the Allegations tab.  

 

You must save (click on the 
Save button) after making 
changes to any row on the 

Allegations tab in order for the 
changes in that row to be  

stored in the  
CONNECTIONS database. 
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Buttons on the Allegations Tab 
The Delete button allows the worker to delete an allegation or modify injury detail. Allegations 
recorded during Intake cannot be deleted. The button is disabled until an appropriate allegation 
is selected. 

The Save button saves changes made to the tab. After saving changes to the Allegations tab, 
attempting to open a tab other than the Investigation Conclusions tab or attempting to close 
the LDM window automatically opens the Investigation Conclusions tab. This allows for the 
review of any changes made to Overall Determinations and the updating of the Investigation 
Conclusions Narrative.  

The Cancel button cancels all changes made to the Allegations tab since the last save. The 
Cancel button is disabled until any changes are made to the Allegations tab. It becomes 
disabled after being clicked until the next time changes are made to the tab.  

If the Overall Determination for the stage changes as a result of the changes made on the 
Allegations tab, the system clears the Current Closure Reason on the Investigation 
Conclusions tab. You must open the Investigation Conclusions tab and select a new Current 
Closure Reason for the stage.  

Other tabs of the LDM window disable if there are any unsaved changes on the Allegations 
tab. 

Clicking on the Close button when there are unsaved changes on the Allegations tab displays 
the following message: “Save changes in progress?” Clicking Yes saves the changes before 
opening the Investigation Conclusions tab. Clicking No discards them and closes the window. 

If the LDM window is entered in view-only mode via the Event List, no fields on the Allegations 
tab are modifiable and the only active button is the Close button. 

 

Step-by-Step: 
Correcting an Allegation 

1 Open the LDM window for the selected stage. 
See “Accessing the LDM Window” on page 44. 

2 Click on the Allegations tab. 

3 Click in the Alleged Subject column and the MA/AB Child column to select different 
persons. 
When you make any changes to the Allegations tab, a pencil displays in the left 
column of the selected row. 

4 Click in the Allegation column of the appropriate row and select the correct 
allegation. 
Use the drop-down arrow to select from the resulting list. 

5 Click to select Substantiated or Unsubstantiated in the Unsub/Sub column. 
Use the drop-down arrow to select from the resulting list. 

6 Click on the Save button. 
The tab displays with the updated changes. 
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7 Click on the Close button. 
The following message displays: “Please update the 
narrative before exiting.” 

8 Click on the OK button. 
The Investigation Conclusions tab opens. 

9 Click on the Narrative button. 
Update the narrative to document the changes to the 
allegations. 

10 Click on the File menu and select Close. 
The following message displays: “Save changes?” 

11 Click on the Yes button. 
The Investigation Conclusion tab displays. 

12 Click on the Close button. 
The following message displays: “Save changes in 
progress?” 

13 Click on the Yes button. 
The following message displays: “Is LDM Complete?” 

14 Click on the Yes button. 
The Case Summary displays. 

15 Click on the Close button. 
The Case List displays. 

 

Step-by-Step: 
Adding an Allegation 

1 Open the LDM window for the selected stage. 
See Accessing the LDM Window on page 44. 

2 Click on the Allegations tab. 

3 Scroll down to a blank row in the upper grid. 
An asterisk (*) appears in the left column. 

4 Click on the drop-down arrow in each column to select the allegation information that 
is being added. 

5 Click on the Save button. 
The Allegations tab displays with the new allegation listed. 

6 Click on the Close button. 
The following message displays: “Please update the narrative before exiting.” 

7 Click on the OK button. 
The Investigation Conclusions tab opens. 

8 Click on the Narrative button. 
Update the narrative to document the changes to the allegations. 

 
Allegations recorded at Intake 

CANNOT be deleted. 

When modifying an injury, make 
sure to select that injury by 

clicking on that row of the lower 
grid before clicking the Delete 
button. Selecting an Allegation 

in the upper grid and NOT 
selecting an injury in the lower 

grid results in the Allegation 
being deleted rather than the 

injury (since only the Allegation 
was highlighted). 
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9 Click on the File menu and select Close. 
The following message displays: “Save changes?” 

10 Click on the Yes button. 
The Investigation Conclusion tab displays. 

11 Click on the Close button. 
The following message displays: “Save changes in progress?” 

12 Click on the Yes button. 
The following message displays: “Is LDM Complete?” 

13 Click on the Yes button. 
The Case Summary displays. 

14 Click on the Close button. 
The Case List displays. 

 

Step-by-Step: 
Deleting an Allegation 

1 Open the LDM window for the selected stage  
See Accessing the LDM Window on page 44. 

2 Click on the Allegations tab. 

3 Select the allegation to be deleted by clicking on that 
row of the upper grid. 

4 Click the Delete button. 
The following message displays:  
“Delete the selected allegation?” 

5 Click on the Yes button. 
The following message displays:  
“Delete Successful.” 

6 Click on the OK button. 

7 Click on the Close button.  
The following message displays:  
“Is LDM Complete?” 

8 Click on the Yes button. 
The Case Summary displays. 

9 Click on the Close button. 
The Case List displays. 

10 Click on the Close button. 
The Case Search Criteria window displays. 

11 Click on the Close button. 
The CONNECTIONS Toolbar displays. 

 
If an Investigation stage was 
closed with the Fatality – No 
Surviving Children closure 
reason, caseworkers cannot 

delete the last allegation against 
a subject who was born less 

than 18 years before the date of 
Intake. Deleting this last 

allegation would change the 
person’s role from Subject to 

Child. If the caseworker 
attempts to delete the last 
allegation, the following 

message displays: 
“Cannot remove allegation.” 
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Step-by-Step: 
Changing Injury Details 

1 Open the LDM window for the selected stage. 
See Accessing the LDM Window on page 44. 

2 Click on the Allegations tab. 

3 Select the allegation in the upper grid that contains the injury that is being changed 
by clicking on that row. 

4 Click on the row in the lower grid that contains the injury that is to be changed. 

5 Click on the drop-down arrow in the injury field and select the correct injury. 

6 Click on the OK button. 

7 Click on the Close button.  
The following message displays:  
“Is LDM Complete?” 

8 Click on the Yes button. 
The Case Summary displays. 

9 Click on the Close button. 
The Case List displays. 

10 Click on the Close button. 
The Case Search Criteria window displays. 

11 Click on the Close button. 
The CONNECTIONS Toolbar displays. 

 

 

You cannot delete an injury if it 
is the only injury recorded for an 
allegation that requires an injury 
detail. If you attempt to do so, 

the following message displays: 
“The selected allegation must 
have at least one associated 

injury. Please make corrections 
or press Cancel.” 



Investigation Conclusions Tab 
The Investigation Conclusions tab allows workers to: 

• view original, previous and current Closure Reasons and Determinations for the closed 
Investigation stage; 

• modify current Closure Reasons for the closed Investigation stage; 

• view Investigation Conclusion narratives for the closed Investigation stage; and 

• append LDM comments to the end of Investigation Conclusion narratives (previously 
entered narrative contents are write-protected). 

The left side of the tab displays information on Investigation Determinations. 

For stages with a WMS case number recorded prior to the implementation of Build 18, a WMS 
Case Number field and a WMS # Validated checkbox display; these fields are not modifiable. 

The Original Determination field is view-only. This information cannot be modified.   

The Current Determination field displays the most recent saved Determination for the stage. 
This field is also view-only. Determination is calculated based on the allegations appearing on 
the Allegations tab.  

When a new “Current” determination is calculated, the previous “current” determination is added 
to the Previous Determination List box (see below) with the current system date and worker’s 
name. 

When an INV stage is first closed, the “current” determination and the “original” determination 
are the same. 

Information on Previous Determinations is contained in the left-hand list box, including Previous 
Determination (the determination type), Date (on which the determination was changed), and 
Changed By (the worker who made the change.) The information in this list box is view-only. 

The right side of the tab displays information on Closure 
Reasons. 

 

If the Overall Determination for 
the stage changes as a result of 

changes made on the 
Allegations tab, the system 
clears the Current Closure 

Reason on the Investigation 
Conclusions tab. Clicking Save 
without selecting a new Current 

Closure reason displays the 
following message: 

“Please select a Closure 
Reason before saving.” 

The Narrative button disables 
until a new Closure Reason is 

selected. 

The Original Closure Reason field is view-only. This 
information cannot be modified. 

The Current Closure Reason field displays the most recent 
saved Closure Reason for the stage and can be modified by 
clicking the drop-down arrow next to the field and selecting a 
new Closure Reason. 

Modifying an “Open” closure reason to a “Closed” closure 
reason, or a “Closed” closure reason to an “Open” closure 
reason, results in the following message being displayed: 
“Remember to update the Case Status if necessary.” This 
message does not display if an “open” closure reason is 
changed to another “open” reason or a “closed” reason is 
changed to another “closed” reason. 
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When a new “current” closure reason is recorded and saved, the previous “current” closure 
reason is added to the Previous Closure Reason list box with the current system date and 
worker’s name. 

Information on Previous Closure Reasons is contained in the list box on the right side, including 
Previous Closures (the Closure type), the Date (on which the Closure Reason was changed), 
and Changed By (the worker who made the change). The information in this list box is view-
only. 

If any changes are made to the information on this tab, the Conclusions Narrative should be 
updated to reflect those changes.  

If you enter the Investigation Conclusions tab after making changes to the Allegations tab, the 
other tabs of the LDM are disabled until the narrative is accessed and changes to the 
Investigation Conclusions tab are then saved. 

If you click on the Save button on the Investigation Conclusions tab without opening the 
Investigation Conclusion narrative, or try to close the LDM window before updating the 
Investigation Conclusions narrative, the following message displays: “Changes to Allegations 
and Investigation Conclusions must have supporting documentation in the Conclusions 
Narrative.” 

Navigation to other tabs or windows is prevented until the narrative is opened.  

• If the LDM window is entered in view-only mode via the Event List, no fields on the 
Investigation Conclusions tab are modifiable and the only active buttons are the 
Narrative button (for opening the Investigation Conclusion narrative in view-only 
mode), and the Close button. If the Investigation narrative is opened, the entire 
narrative is view-only with no modifications permitted. The “Narrative entered by…” 
line is not added to the narrative. 

• If an update to the INV Conclusion Narrative is not completed in a single session, the 
text of the update is interrupted by the “Narrative entered by…” marker line. 

• Other tabs of the LDM window are disabled when there are any unsaved changes on 
the Investigation Conclusions tab. 

• If information on the Investigation Conclusions tab is changed but the changes are 
not saved, clicking the Close button displays the following message: “Save changes 
in progress?” Clicking Yes saves the changes before closing the window. Clicking No 
discards them.  

Buttons on the Investigation Conclusions Tab 
The Narrative button opens the Investigation Conclusion narrative.  

The Risk Comments button opens the Current Risk Comments window. If a closed stage has 
an associated RAP with a Final Risk Rating of High or Very High and you change the current 
Closure Reason, you may need to record High Risk Comments for the new Closure Reason. 
Comments are required when the Final Risk Rating is High or Very High and the Closure 
Reason is “Closed – No services required.” If the stage already has High Risk Comments 
recorded for the Current Closure Reason, you may be able to add comments. You are also able 
to view the High Risk Comments associated with the Previous Closure Reason.  
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When changes or additions are completed in the Additional Risk Comments field, clicking on 
the OK button stores the changes and closes the window. The OK button does not save the 
changes, but stores them locally until you click on the Save button on the Investigation 
Conclusions tab.  

This button does not display in the Investigation Conclusions tab for IAB Investigations. 

The Save button saves changes made to the tab and is disabled until any changes are made on 
the Investigation Conclusions tab. 

The Cancel button cancels all changes made to the Investigation Conclusions tab since the 
last save. Clicking it displays the following message: “Your changes will be lost. Continue?” 
Clicking Yes discards any unsaved changes. Clicking No returns you to the Investigation 
Conclusions tab without discarding the changes. The Cancel button is disabled if any changes 
are made to the Allegations tab. The Investigation Conclusions tab must be modified to 
support those changes and then saved. 

Closing and Minimizing the Investigation Conclusion Narrative 
You can close the Investigation Conclusion narrative by clicking on the File menu and selecting 
Close. Alternatively, you can click on the Close button ( ) in the upper right corner of the 
Word document window.  

• Closing the narrative using either of these methods displays a message asking you to 
confirm the save. 

• Either method saves the narrative to the CONNECTIONS database and returns you to 
the Investigation Conclusion tab with the Narrative button visible.  

Rather than closing the narrative, you can minimize it using the Minimize button ( ) in the 
upper right corner of the Word document window.  

To re-open a minimized narrative, click on either the narrative’s Task Bar button at the bottom 
of the screen or the Narrative button on the Investigation Conclusions tab. 

 

Step-by-Step: 
Updating the Investigation Conclusions Narrative 

1 Open the LDM window for the selected stage. 
See “Accessing the LDM Window” on page 44. 

2 Click on the Investigation Conclusions tab. 

3 Click the Narrative button in the bottom left corner of the tab. 
The Investigation Conclusion narrative will open in a separate window. All previously 
entered information in the narrative will be view only. The following text will be added 
to the end of the narrative: “The following narrative section entered by <worker 
name> <(worker’s person ID)> on <date> at <time>.” 

4 Enter any new comments after the above text. 

5 Click on the File menu and select Close. 
The following message displays: “Save Changes?” 
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6 Click on the Yes button to save changes. 
The Investigation Conclusion tab displays. 

7 Click on the Close button 
The following message displays: “Is LDM complete?” 

8 Click on the Yes button. 
The Case Summary window displays. 

Notice of Unfounding Letters and LDM 
All of the work done in LDM is in closed stages; because of this, the CONNECTIONS system-
generated letters operate differently than in the open stages. To allow for potential LDM 
changes to closed INV stages, the generation of Notices of Unfounding by batch process is 
delayed until 14 days after the approval of the Investigation Conclusion. 

A Notice of Unfounding is not printed if an in-process LDM event exists. 

If an unfounded INV stage has an In-process LDM event that was initiated less than 14 days 
after the INV closing date, a Notice of Unfounding is not printed until 14 days after the LDM 
event status has been updated to Complete.  

The notice is not printed at all if the event was initiated more than 14 days after the INV stage 
was closed. Local Districts are responsible for creating and mailing Notices as a result of LDM 
changes to the determination that occur more than 14 days after the INV closing date. 

A person who is younger than 18 and is a non-confirmed subject in an unfounded INV stage 
receives a Notice of Unfounding. 

LDM Online Help 
CONNECTIONS provides an extensive Help program. It contains information on all functions of 
LDM, as well as policy and procedure guidelines, law and definitions. Context-sensitive help 
information is available for all elements of the LDM window including tabs, grids, buttons and 
individual fields. Click on an element to make it “active” and press the F1 key on your keyboard. 
Information about that element of the LDM window is displayed.  

LDM Online Help includes the following features: 

 

When you are viewing the 
Investigation Conclusion 

narrative, the F1 key does not 
activate LDM Help  

• A Table of Contents allowing access to all Help 
information. 

• Index and Search functions providing alternate means of 
finding information. 

• Interactive graphic examples of LDM window elements. 
Clicking on certain portions of a graphic within LDM 
Online Help displays explanations of that element.  

• Hyperlinks appear throughout the Help information. These links take you directly to 
related information such as definitions and procedural guidelines. 
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Pressing the F1 key opens the LDM Help system. Information specific to the LDM window 
element that was active when the F1 key was pressed will display. Once in the Help system, the 
Table of Contents allows access to Help information on other elements of the LDM window. 

Besides context sensitive Help information on LDM window elements such as fields, tabs, and 
buttons, the LDM Help system includes the following: 

• LDM Overview: A high level summary of LDM including a listing of its features and 
functions. This overview can be accessed directly by clicking on the Help menu on 
the LDM window and selecting the LDM Help command. 

• “How Do I?” Information on how to navigate within the LDM window and how to 
best utilize its functions. 

• Glossary: Definitions of terms commonly used in casework as well as definitions of 
LDM window elements and concepts. 

• Guidelines: Background on the legal, policy, and procedural guidelines followed by 
workers as they develop and record information in the LDM window. 

• Help on Help: Instructions on how to use the LDM Online Help system.  

Key elements of the information in this Step-by-Step Guide relating to features and functionality 
of the LDM window can also be found in the LDM Online Help. 

You may have access to the Internet via your CONNECTIONS computer; there are some 
security issues to keep in mind regarding Internet use. Only connect to the Internet for purposes 
authorized by your district/agency. You should not use the Internet for any reasons that could 
breach security. This includes accessing external e-mail accounts (e.g., Hotmail or Yahoo). 

 

Step-by-Step: 
Accessing LDM Online Help 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the Case ID or Case Name in the appropriate field. 

3 Click on the Search button. 
The Case List displays.  

4 Click on the case to be viewed/updated. 

5 Click on the Summary button. 
The Case Summary window displays. 

6 Click to select the INV stage to be viewed or updated. 

7 Click on the Options menu and select Maintain Closed Investigation. 
The LDM window opens with the Person Demographics tab displayed. 

8 Click in any field on the Person Demographics tab to make it active. 
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9 Press the F1 key on the keyboard. 
LDM Online Help information displays for the 
selected field. 

 

If an LDM event is left in PROC 
status for more than 7 days, 

CONNECTIONS generates an 
Alert on the caseworker’s Staff 
To-Do List. The Description 
column for the alert reads, 
“Complete in process LDM 

event created <date>.” 

10 Click on the Contents tab and click on any of the 
items listed. 

11 Click on the Close button to close the topic. 

12 Click on the Index tab and click on any item listed. 

13 Click on the Close button to close the topic. 

14 Click on the Search tab and enter search criteria. 
Review the results displayed. 

15 Click on the Close button. 
The LDM window displays. 
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Module 4: 
Support Tools 

When you’re using CONNECTIONS, you may have questions that are not answered in this 
guide. There is a wealth of additional information available to you that will help you answer 
these questions. 

By the end of this module, you will be able to: 

• access Online Help for assistance in accomplishing CONNECTIONS tasks; 

• contact the Help Desk to get basic trouble-shooting questions answered; and 

• access Step-by-Step Guides and Job Aids, including the CONNECTIONS Step-by-Step 
Guide: Training for CPS Workers, from the OCFS CONNECTIONS intranet site. 
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Online Help 
The CONNECTIONS Online Help feature provides descriptions for various windows, as well as 
step-by-step instructions for common tasks. You can access Online Help at any time, from any 
window in CONNECTIONS. There are different ways to access Online Help: you can click on 
the Help menu in CONNECTIONS or you can press the F1 key on your keyboard to access 
context-sensitive Online Help.  

The Contents, Index and Search tabs in Online Help allow you to search for and navigate to 
the topic(s) you need help on. 

Updates to Online Help content and functionality in CONNECTIONS are ongoing. As part of 
recent updates, new Online Help functionality has been added for Family Services Stage 
windows, as well as Child Protective Record Summary windows and Foster and Adoptive Home 
Record Summary windows. When you click on Help from any of those windows, a context-
sensitive drop-down Help menu displays. For example, from the Progress Notes window, 
clicking on Help displays Progress Notes Help and from the Child Protective Record Summary 
window, clicking on Help displays CPRS Help. 

 

Step-by-Step: 
Accessing Online Help 

1 Click on the Help menu on the CONNECTIONS Toolbar. 
The following list of commands displays: 

Contents A table of contents for the help facility with links to major sections. 
How Do I? Step-by-step instructions to help you complete tasks using 

CONNECTIONS.  
Window 
Descriptions 

Descriptions of windows in CONNECTIONS, along with information on 
various fields. 

DSS Policy Online OCFS policy handbooks (under revision). 
Help On This 
Window 

Window description help for the window you are on. 

Help for Help Instructions on how to use the help functionality.  
About 
CONNECTIONS 

Information about the current CONNECTIONS version and build. 

2 Click on a command from the Help menu. 
The window related to your selection displays. In some cases, you will need to make 
another selection in that window to obtain instructions. At the top of each window, 
you’ll see additional buttons and menus. Use the Search button to search for 
specific information in the Help function and use the Back button to return to 
windows you’ve just visited in Help. The Glossary button opens a list of important 
CONNECTIONS terms and the Print button allows you to print Help information. 

3 When you’re done reviewing information in Help, close each Help window by clicking 
on the Close button ( ) in the top right corner of the window. 
The CONNECTIONS Toolbar displays. 
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Enterprise Help Desk 
The New York State Office for Technology (NYS OFT) Enterprise Help Desk staff are available 
to answer basic questions related to your equipment, or to solve problems you’re having with 
the CONNECTIONS application. If they cannot solve your problem, they will record your 
information and forward it to others who can. 

Your agency may have procedures in place for contacting the Help Desk. Check with your 
supervisor before you call. 

The Help Desk is staffed 24 hours a day, seven days a week. The telephone number is: 

1-800-NYS-1323 
(1-800-697-1323) 

When you call the Help Desk with a problem, you will be given a ticket number to use for 
tracking your issue and its resolution. Keep a record of this number; you will need it for any 
follow-up conversations with the Help Desk. 

OCFS CONNECTIONS Intranet Site 
A variety of training-related materials are available from the OCFS CONNECTIONS intranet site 
(http://ocfs.state.nyenet/connect/). The intranet site contains a wealth of information related to 
various aspects of CONNECTIONS, including training schedules, Alerts and Notices, Step-by-
Step Guides (including the CONNECTIONS Step-By-Step Guide: Training for CPS Workers), 
Job Aids and Frequently Asked Questions (FAQs). 

 

Step-by-Step: 
Accessing the OCFS CONNECTIONS Intranet Site 

1 From your desktop, double-click on the Internet Explorer icon. 

2 If the browser does not display the OCFS intranet site automatically, enter 
http://ocfs.state.nyenet into the browser’s address line and press the Enter key on 
your keyboard. 
The OCFS intranet home page displays. 

3 Click on the CONNECTIONS link. 
The OCFS CONNECTIONS intranet home page displays. 

4 Click on a topic to access information. 
For access to various Step-by-Step Guides and Job Aids, click on the Step-by-
Step/Job Aids/Tips link. 

5 To close Internet Explorer, click on the File menu and select Close. 
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